


Before reading this User's Guide and returning your registration card, please note below 
the serial number of your Gold card (which can be found on the back of the card) and the 
version number of the Gold software ( which can be found on the Ad Lib Gold Program 
Disks). This information will be needed when calling our Customer Se nice or Technical 
Support Department. 

Serial Number 

Version Number 

' • 
WARNING: Your Ad Lib Gold card is packaged in special material 
designed to protect it against static electricity. We recommend that you 
keep it in this package until you are ready to install it in your computer . 
Electronic boards can be easily damaged with static electricity and must 
be handled with care. Users should ground themselves before handling the 
card. Please read the manual before beginning installation. 
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Copyright 
This manual and the product and programs it describes are protected by copyright laws and 
therefore may not be reproduced (except to make a backup copy), in whole or in part, whethi 
sale or not, without written consent from Ad Lib MultiMedia Inc. Under copyright law, copyin, 
includes translation into another language or format. 

The purchaser may use the programs on any computer in his or her possession, but only on on 
computer at a time. 

Ad Lib, Visual Composer, Juke Box and Voice Pad are registered trademarks of Ad Lib MultiM 
Inc. Autodesk Animator is a trademark of Autodesk, Inc. IBM PC, XT, AT and PS/2 are registe1 
trademarks of International Business Machines Corporation. Tandy is a registered trademark 
Tandy Corporation. PC/MS-DOS, Windows and Microsoft are registered trademarks of Microso 
Corporation. Mouse Systems is a trademark of Mouse Systems Corporation. 

Limited Warranty 
Ad Lib MultiMedia Inc. warrants the Ad Lib Gold Stereo Sound Adapter to be free of any defec 
materials or workmanship for a period of twelve (12) months from the date of purchase. Ad Li 
MultiMedia Inc. warrants Ad Lib Gold software programs to be free of any defects in material , 
workmanship for a period of ninety (90) days from the date of purchase. These warranties are 
limited to the original purchaser of the product and are not transferable. 

Ad Lib MultiMedia Inc. will, repair or replace any product component or documentation, at its 
option and at no additional charge, if found defective within the warranty period. The purchas 
responsible for returning the product at his own expense to Ad Lib MultiMedia Inc., and must 
provide a dated proof-of-purchase and/or have a registered warranty card for said product on f 
with Ad Lib MultiMedia Inc. 

Ad Lib MultiMedia Inc. will not be held responsible in any way whatsoever for refund, repair 01 

replacement resulting from improper installation, accident, misuse, or from service or 
modification of the product by anyone other than Ad Lib MultiMedia Inc. or an authorized Ad I 
service center. 

Ad Lib MultiMedia Inc. will not be held responsible in any way whatsoever for direct, indirect, 
special, incidental, or consequential damages resulting from possession, use, improper 
installation, accident, service, modification or malfunction of the product. 

This warranty is in lieu of all other warranties, whether oral, written, expressed or implied, 
including any warranty of merchantability or fitness for a particular purpose, and no other 
representation or claims of any nature shall be binding on or obligate Ad Lib MultiMedia Inc. 

This warranty gives you specific legal rights. You may have other rights according to your locali 

Warning 
This equipment generates and uses radio frequency energy, and if not installed and used prope 
(i.e. in strict accordance with the manufacturer's instructions), may cause interference to radi 
and television reception. It has been tested and found to comply with the limits for a class B 
digital device in accordance with the specifications in Subpart B of Part 15 of FCC Rules, whicl 
are designed to provide reasonable protection against such interference in a residential 
installation. 



is device complies with part 15 of the FCC Rules. Operation is subject to the following 
o conditions: (1) this device may not cause harmful interference, and (2) this device 
1st accept any interference received, including interference that may cause undesired 
eration. 

~et\.\)\\eta\s \CClffi\\ll.tet i\\\\ll.tlClll.t\\ll.t de'li.ces, tetm\.na\s, \\tintets, etc.) cettmed to com\)\'i 
the c\ass ~ \imits may be attacheo to tnis eqll.ipment. 011eration wi.tn non-certil\ed 

11nera\s is \i\<.e\')' to result in intertetence to raoio anu TI teCe'\ltion. Y\lftnetmote, tne use ot a 
-shielded 1/0 cable with this device will not enable the device to meet the maximum emission 
lts man oaten by U.S. federal law. 

ire is no guarantee that interference will not occur in a particular installation. If this 
1ipment does cause interference to radio or television reception ( this can be determined by 
ning the equipment off and on), the user is encouraged to try to correct the interference by one 
nore of the following measures: 

• Reorient the receiving antenna. 

• Move the computer away from the receiver. 

• Plug the computer into a different outlet so that computer and receiver are on different 
branch circuits. 

ecessary, the user should consult the dealer or an experienced radio/television technician for 
litional suggestions. The user is hereby notified that changes or modifications not expressly 
,roved by Ad Lib MultiMedia Inc. could void the user's right to use the equipment. 

, user may find it helpful to consult the booklet: 
>w to Identify and Resolve Radio-'IV Interference Problems", prepared by the Federal 
11munications Commission. This booklet is available from the U.S. Government Printing Office, 
shington, DC 20402, Stock No. 004-000-00345-4. 

chnical Support 
Lib MultiMedia Inc. is firmly committed to providing the highest level of customer service and 
duct support. If you experience any difficulties when using our product, or if it fails to operate 
lescribed, we suggest you first consult the User's Guide, and then, if you are still in need of 
istance, call our Technical Support Department: 

,phone: ( 418) 529-6252 

1rs, Monday to Friday: 

• North American Eastern Time: 10 a.m. to 5 p.m. 
or 24 hours w/automated system. 

1tice 
Lib MultiMedia Inc. reserves the right to make changes or improvements in the product 
,cribed in this manual at any time and without notice. 
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lntroductio 
Welcome to Ad Lib Gold™ 
Welcome to Ad Lib Gold, the powerful line of multimedia audio adapters from Ad Lib 
MultiMedia Inc. Ad Lib Gold is an advanced audio solution for those who use all the 
great new sound-enabled applications for business, multimedia, training, education 
and entertainment. 

The tasks you can enhance with Ad Lib Gold are countless: 

• Add soundtracks and unique sound effects to your multimedia sales presentatio 
to motivate or inspire 

• Record voice notes as verbal explanations or reminders right into your sound­
enabled spreadsheet or word processing programs 

• Listen to excerpts from great composers or the sounds of battles of yore just by 
browsing through the audio database of a computer CD-ROM encyclopedia 

• Eajoy all the amazing new entertainment titles with soundtracks specially writt1 
for Ad Lib Gold 

• Compose your own musical pieces right on screen or using a MIDI device 

• Improve your productivity using Ad Lib Gold and text-to-speech software to 
proofread texts or spreadsheet figures. 

The applications for Ad Lib Gold are as limitless as your imagination! 

This manual provides a complete description of Ad Lib Gold hardware and installatio1 
for model 1000 and explains how to use the handy software Ad Lib has included to he! 
you get the most out of your audio adapter. Be sure to read the chapters on: 

• Mixer Panel TSR, which controls mixing functions such as volume, balance and 
tone 

• Juke Box Gold™, a music playback program that includes a music clip library in 
variety of styles and that even lets you listen to songs you have composed yoursel 

• Voice Pad™, an application for recording, editing, managing and playing back 
voice memos and voice alarms 

• Soundtrack Synchronization Editor, which allows you to time-synchronize 
computer soundtracks to your slide shows or animated presentations 

• Soundtrack Playback Driver, for playing back your Sync files created with 
Soundtrack Synchronization Editor 
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Autodesk Animator Playback Utility, for synchronizing frames and sounds in 
presentations created with Autodesk Animator or Animator Pro 

Batch File Utilities, for playing back ROL2 and Digitized Sound files 

II quickly come to appreciate Ad Lib Gold for its unrivalled flexibility and 
1lness. And, thanks to Ad Lib Gold's open architecture design, you'll be able to 
ade your audio adapter to keep pace with your changing requirements. Ad Lib 
'S two different add-on modules: 

The Ad Lib Surround Sound Module -This piggyback card clips right onto your 
Gold card and adds a whole range of unique sound enhancements, such as reverb 
and echo. 

The Ad Lib CD-ROM Adapter Kit - This piggyback card offers Ad Lib Gold 1000 
owners a convenient upgrade path for adding CD-ROM capabilities to their 
Ad Lib Gold cards. 

~omplete information on Ad Lib's add-on products, call us today at 418-529-9676 or 
~ Ad Lib MultiMedia Inc., Customer Service Dept., 220 Grande-Allee East, Suite 
Quebec, QC, Canada G IR 2J I. 
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Ouick Star 
This Quick Start is intended for the experienced PC user who has already installed an 
used various hardware and software applications. Do not attempt a Quick Start 
installation if you are not familiar with the PC environment; installation errors could 
occur that will be difficult to correct afterwards. This Quick Start includes references 
to the User Guide for those who need more complete information on a particular 
hardware or software installation step. 

Installing the Hardware 
Installing the Gold card 

1. Make sure that the on-board jumpers, the "game port enable jumper", the "port 
address jumper" and the "dual joystick selector jumpers", are in the desired 
position. Default factory settings should be satisfactory for most users. 

n See pages 3-14 and 3-15. 

2. Plug the Gold card into the computer in a free slot as far as possible from the 
video adapter card. 

~ NOTE: Certain cards, such as video adapters, produce high­
frequency signals which can interfere with the sound quality 
of the sound card. 

n See "Getting Installed: Installing the Hardware". 

Connect the Other Peripherals 
• Plug headphones or external speakers into the main audio output of the card, or 

connect the output to the input of a stereo system. 

• Connect your low impedance microphone to the microphone input of the card. 
(optional) 

• Connect the output of your stereo source (CD player, CD-ROM drive, synthesizer 
or cassette player) to the stereo auxiliary input of the card, using a stereo cable. 
(optional) 

• Connect your joystick to the DB-15 game port of the card. If you plan to use the 
MIDI interface, connect your MIDI device using the enables supplied in the 
Ad Lib MIDI Pak. (optional). 

n See "Getting Installed: Installing the Hardware". 
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:talling the Software 
td the README.TXT File 
:uggest that you examine the README.TXT file prior to installing the software. 
file contains information on the latest program updates, and other necessary 
:mation. 

Insert the Ad Lib Gold Disk 1 into the floppy drive, set the current drive to A 
(or B, depending on which drive you are using), and type the following command: 

A:\ >type readme.txt 

;all Gold Applications and Resources 
Run the Gold Setup Program by typing the following command: 

A: \> setup 

See "Getting Installed: Software Installation and Configuration''. 

t Hardware and Software 
e installation is complete, run the Test program to verify that the Ad Lib Gold 
!ware and software are functioning properly. 

Go to the directory where you placed the Gold Test Program at installation and 
load this program by typing the following command: 

testgold 

See "Getting Installed: Testing the Hardware". 

:ing the Gold Card 
nning Gold DOS Applications 
:e the Gold hardware and software are installed, you can run any Ad Lib Gold 
lication by proceeding as follows: 

Set the current directory to the one where you placed the Gold programs during 
the installation process. 

Load the Mixer Panel TSR program first, which serves to control the different 
sound parameters (balance, tone, volume, etc.), by typing the following command: 

mixer 

2-7 
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3. Load the program you want by typing the corresponding command: 

jukegold Juke Box Gold Music Playback Program 

voicepad Voice Pad Record and Playback Program 

st racked Soundtrack Synchronization Editor 

strkdrv Soundtrack Playback Driver (followed by the Sync file name) 

playanim Autodesk Animator Playback program (followed by the .FL! fil1 
name) 

playrl2 ROL2 Playback batch file utility (followed by the .RL2 file nam 

playdigi Digitized Sound Playback batch file utility (followed by the .S!V 
file name) 

Except for the Mixer Panel TSR, applications offer on-line Help containing summari, 
information on how to operate the program and how to use the various features. 

Running a Third Party Program 
To run a third party program supporting the Gold card, proceed as follows: 

1. Make sure the Ad Lib Gold hardware and software are correctly installed and 
working properly. 

2. Install the program or game according to the manufacturer's instructions, maki 
sure you specify the Ad Lib Gold card in the installation options, if requested. 

3. Load the Mixer Panel TSR program first, by typing the following command: 

mixer 

4. Load the program by typing the appropriate command. 

When running a program with the Gold card, you can adjust output volume at any tim 
without opening the Mixer Panel, using the following shortcuts: 

fA]l f[Q] i]] For increasing output volume. 

lfA!t] I ◊ ] @] For decreasing output volume. 

n See "Mixer Panel TSR". 
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Description of the Hardwa1 
Functionality 
Your Ad Lib Gold Stereo Sound Adapter is a multifunction card with digital recordin 
playback of digitized and synthesized sounds, analog audio mixing, MIDI recording a 
playback, game port, and CD-ROM interface (optional with Gold 1000). 

Digital Recording 
With the Ad Lib Gold card, you can record from: 

• A low impedance microphone, using Voice Pad, the Windows Sound Recorder 
or Studiosonic 8. 

• An audio tape or a compact disk, using Voice Pad, the Windows Sound Recorde 
or Studiosonic 8. 

Digitized and Synthesized Sound Playback 
With the Gold card, you can play back: 

• Digitized sounds: The Gold card has two channels for digitized sounds. These 
channels can be used in a variety of ways, such as for voice notes with the Voicl 
Pad program, percussion sounds in the Juke Box Gold songs, voiceover in 
Soundtrack Playback Driver, or third party software using stereo music or musi 
with voiceover. 

• Synthesized sounds: The Gold card has a 20-voice FM synthesizer which is used 
for Juke Box Gold songs and third party software music. 

The sound capability of the Gold card also features: 

• Audio mixing: The internal analog mixer of the Gold card controls the volume o 
various audio sources, through programming, such as within third party softwa1 
or manually using the Mixer Panel (see "Mixer Panel TSR" section). 

• Volume control: The output volume of the Gold card is software controlled (see 
"Mixer Panel TSR"). 

• Tone control: Bass and treble controls are software controlled (see "Mixer Panl 
TSR"). 



AdLib 
GOLD Desciription of the Hardware 

Functionality 

I Recording and Playback 
UDI (Musical Instrument Digital Interface) interface of the Gold card allows 
files to be recorded and played back using Ad Lib MIDI Pak optional, any 
nal MIDI instrument and an Ad Lib Gold supporting sequencer program. 

e Port 
,d Lib Gold card allows a standard IBM compatible joystick to be connected. 

WM Interface 
/old card CD-ROM interface (optional with Gold 1000) allows a CD-ROM drive 
connected. 

uut of the Card 
~ket Connectors 
b Gold Stereo Sound Adapters have three 1/s" connectors and one DB-15 
ictor on the support brackets, as shown in the diagram (Figure 1). 

: connectors are: 

fhe low impedance microphone input (No. 7), for sampling and/or mixing with 
other audio sources. 

The stereo auxiliary input (No. 8), for connecting an external source such as a CD 
or cassette player, a synthesizer or any audio source, in order to sample and/or 
mix with other audio sources. 

The main stereo audio output (No. 9), for connecting to standard headphones, 
bookshelf speakers or a stereo system. 

fhe Game Port/MIDI connector (No. 10), for using a standard PC joystick and/or a 
MIDI device (using ajoystick does not require MIDI Pak). Connecting a MIDI 
device requires an optional MIDI Pak available from Ad Lib MultiMedia. 

3-11 
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On-Board Connectors and Main Components 
Ad Lib Gold Stereo Sound Adapters have on-board connectors to support many 
different options and internal/external devices. These connectors are shown in the 
diagrams (Figure 1). 

These connectors are: 

• On model Gold 1000, the CD-ROM option connectors (Figure 1: No. 20), to sna1 
on a CD-ROM piggyback board. This as used to attach a CD-ROM drive. 

• The Surround Sound option connectors (No. 1), to connect a Surround Sound 
Module. This module is used to provide stereo and depth enhancements. 

• The internal stereo auxiliary input (No. 4), to connect a PC internal audio devi 
(such as an internal CD-ROM drive) for direct input. This connector is in paral 
with and has exactly the same functions as the external stereo auxiliary input 
connector on the support bracket. 

~ NOTE: It is not recommended to use both the e.xternal and inter 
nal stereo auxiliary input at the same time, because this will 
decrease the volume of the auxiliary audio source. 
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16 15 13 12 11 

Figure 1: GoW 1000 diagram 

8. Stereo aux. input 
9. Main audio output 

10. Game port/MIDI DB-15 
connector 

I 1. Dual joystick selector 
jumpers ( JP2-7) 

12. Port address jumper 
(JPS) 

13. Control chip reset jumper 
(JP9) 

14. Custom control VLSI chip 
15. Bus connector 
16. Game port enable jumper 

(JPl) 
17. 16-bit FM DAC 
18. Professional FM synthesis 

chip 
19. Sampling 12-bit DAC and 

MIDI chip 
20. CD-ROM option 

connector 
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The On-board Jumpers 
To make it easier to configure the Ad Lib Gold card, we have made the Interrupt Iii 
(IRQ) and OMA channels software selectable, thereby keeping the amount of jump 
to a minimum. The four remaining jumper sets are the game port enable jumper, ti 
dual joystick selector jumpers, the port address jumper and the Control chip reset 
jumper. 

? • 
DMA stands for Direct Memory Access. With DMA, a periphera. 
can access computer memory without intervention of the 
central processing unit (CPU). This technique allows the 
speeding up of overall operation. 

The Gold card jumpers are the following: 

• Game port enable jumper (No. 16) 
This jumper lets the user enable/disable Ad Lib Gold's on-board game port 
interface. The interface should be disabled in cases where the user already h, 
standard PC game port interface inside his/her PC, to avoid conflicts. 

Jumper setting is shown here: 

• • Game port enabled Game port disabled 

Figure 3: Game port jumper enabling 

~ NOTE: The jumper is factory set to the game port enabled 
position. 

• Dualjoysticksewctorjumpers (No.11) 
These jumpers let the user change the factory-set 'joystick plus MIDI" option 
jumpers on the bracket side, pins No. 2-3) to the "two joysticks without MIDI 
option (all jumpers on the opposite side, pins No. 1-2). All jumpers in this 
selector must be changed to the same position, as shown in the following 
illustrations. 
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Single joystick with MID I 
option (factory-set) 

Dual joystick option 

Figure 4: f)ualjoystickjumper selection 

'art address jumper (No. 12) 
his jumper lets the user choose a single or double port address for the Gold card. 
'he Ad Lib Gold card addresses can be assigned by software programming. The 
efault port address of the Gold card is 388H and can be changed by software in 
ases where another card inside the PC uses the same address, in order to avoid 
onflicts. In the case where the software cannot recognize the programmed 
ddress, the port address jumper is used to force the Gold card into answering at 
,oth the programmed address and at the default factory address 388H. 

• NOTE: The port address jumper is factory set to single port 
address position {jumper plugged on the two upper pins) which 
enables only one port address to be used at a time.* 

'he port address jumper can be changed to double port address position Gumper 
1lugged on the two lower pins) which forces the default address 388H to be used 
n conjunction with any other user-defined one. 

7ontrol chip reset jumper (No. 13) 
'his jumper is used where the programmed configuration of the Control chip is 
ost. In some cases, losing the configuration can cause the card to use addresses 
hat are already in use by other hardware. Changing the position of the Control 
:hip reset jumper from the two left pins to the two right pins disables certain 
'unctions of the Gold card that could cause hardware conflicts. Once the jumper 
s plugged on the two right pins, reconfigure the Gold card to the factory preset 
1alues by issuing the following command: 

;etup /R 

ould be kept in the single port address position. Double port address position sould only be 
in maintenance procedures. 
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Once the Gold card is reconfigured, replug the Control chip reset jumper ont 
two left pins. 

~ NOTE: You do not need to change the position of the Control 
chip reset jumper to issue the command setup /R. Change 
the position of the jumper only when the hardware conflicts 
prevent the computer from rebooting. ( See ''Appendix A: 
Troubleshooting'; Problem No. 12,for details.) 

Available Interrupt Lines and DMA Channels 
• There are four software selectable interrupt lines (IRQ 3, 4, 5 and 7) on the 

Gold 1000. 

• OMA channels 1 and 3 are software selectable on the Gold 1000. 

? • 
Interrupt is a computer instruction that halts program 
processing momentarily, so that other operations can take 
place. Once this operation is finished, the computer resumes tt. 
initial program processing. 



Getting Installed 



________ AdLib 
Getting Installed 
System Requirements 

GOLD 

4- 18 

Getting Install 

System Requirements 
To use the Ad Lib Gold card and the Gold software, you need the following: 

1. For the Gold 1000: an IBM PC, XT, AT (286), 386 and 486 compatible or Tand 
computer, a disk drive (720 KB 3 ½") and 640K of RAM. 

2. A hard disk. 

3. Graphics adapter, VGA is recomemded. 

4. MS-DOS 3.0 or higher. 

5. Headphones, external speakers or a home stereo system. 

6. A microphone (low impedance). 

Installing the Hardware 
We suggest that you read this section thoroughly before you begin. This will familh 
you with the standard installation procedure. 

These instructions are for installing your Ad Lib Gold card in your computer. We 
recommend that you read the owner's manual supplied with your computer for 
instructions specific to your model of computer. 

Hardware Configuration Settings 
To install the Ad Lib Gold card, there are two types of configuration settings: hard' 
settings and software settings. The Gold card uses software for most of the 
configuration settings ( see the sections on installation and configuration below). 
Only three hardware settings, made with jumpers, are necessary: game port 
enabling/disabling, dual joystick selection and port address. These should be madi 
before installing the Gold card in your computer. 

Note that the default factory settings should be suitable for most users. 
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t Game Port Enable/Disable Jumper 

1me port enable/disable jumper lets the user enable or disable Ad Lib Gold's on­
game port interlace. The interlace should be disabled in cases where the user 
ly has a standard PC game port interlace inside his/her PC, in order to avoid 
;ts. The factory settings enables the game port. To obtain the desired setting: 

,ocate the jumper for the game port enable/disable setting (refer to Figure 1, 
fo . 16). 

f your computer does not have a game port, make sure that the jumper is over the 
wo right pins as shown in Figure 3. This jumper is factory set in the game port 
mabled position. 

fyour computer has a game port, unplug the jumper from the two right pins and 
·eplug it onto the two left pins as shown in Figure 3. 

t Dual Joystick Selector Jumpers 

~al joystick selector jumpers let the user change the factory-set "one joystick plus 
'option to the "two joysticks without MIDI" option. The factory setting is for "one 
:k plus MIDI option. All jumpers in this selector must be changed to the same 
Jn, as shown in Figure 4. To obtain the desired setting: 

,ocate the dual joystick selector jumpers (refer to Figure 1, No. 11). 

fyou wish to use the Gold card's game port in the "single joystick with MIDI 
)ption", leave the jumpers in the factory-set position (i.e. plugged onto the 
Jracket side of the card, pins No. 2-3) as shown in Figure 4. 

If you want to use the Gold card's game port in the "dualjoystick option", unplug 
111 sixjumpers and replug them onto the opposite side (pins No. 1-2), as shown in 
figure 4. 

t Port Address Jumper 

ort address jumper lets the user choose a single or double port address for the 
:ard. The default port address of the Gold card is 388H. It can be changed with 
itup program in cases where another card inside the PC uses the same address as 
j Lib card. 

ort address jumper is factory set to the single port address position which enables 
,ne port address to be used at a time. These port addresses can be modified by 
ue. It can be changed to double port address position, which forces the default 
ss 388H to be used in conjunction with any other. This should be used only for 
: purposes, or when resetting the card with "setup/ r ". 
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To obtain the desired setting: 

1. Locate the jumper for the port address setting (refer to Figure 1, No. 12). 

2. If you wish to use only one port address at a time (388H or any other), make 1 

that the jumper is over the two upper pins. This jumper is factory set in the si 
port address position. 

3. If you wish to force the default port address 388H to be used in conjunction\\ 
another one, unplug the jumper from the two upper pins and replug it onto tt 
two lower pins. 

Removing the Computer Cover 
1. Switch off the computer. 

2. Disconnect the power cord and all peripheral devices and cables. 

3. Set the computer on a flat, clear surface. 

4. Remove the mounting screws that hold the computer cover. 

5. Remove the computer cover. 

Removing the Slot Cover 
1. Choose a free slot as far as possible from the video adapter card. 

~ NOTE: Certain cards, such as video adapters, produce high­
frequency signals which can interfere with the sound quality q, 
the sound card. 

2. Remove the screw that holds the slot cover in place. 

3. Lift the slot cover to remove it. 

' • 
WARNING: If a screw falls into the computer, you absolutely 
must remove it before switching your system back on. If a meta 
object is left loose inside the casing of your computer, it may 
cause a short circuit that will damage your system. 
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lling the Gold Card 
lace the card immediately above the slot without inserting it into the socket. 

lake sure that the bracket is inserted in the groove previously occupied by the 
lot cover. 

ress the card down into the socket. 

ut the card's bracket screw back on and tighten it. 

ut the computer cover back on and tighten the screws . 

. econnect the power cord and other cables. 

ecting Other Peripherals 
rd is equipped with jacks and plugs for connecting various peripherals. These 
levices to be connected to: stereo audio output, microphone input, line-level 
audio input and MIDI/game port. 

Output 

,Id card is equipped with three 1/H" jacks for connecting audio equipment. 
1in audio output is the lowermost of the three jacks, located above the DB-15 
:tor (refer to Figure 1, No. 9). This jack can be connected to headphones, 
al speakers or a stereo system using stereo adapters and cables. To avoid 
ion when connecting to a stereo system, connect the card to an auxiliary-type 

phone Input 

N impedance microphone input is the uppermost of the three audio jacks on the 
bracket (refer to Figure 1, No. 7). This connector lets the audio signal from a 
.rd microphone be mixed with other audio sources or to be used as a source for 
ngsounds. 

NOTE: The microphone input impedance of the Gold card i,s 
1 KQ. The microphone should have a maximum impedance 
of 1 KQ if you do not want to lose too much input level due to 
an impedance mismatch. 
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Stereo Auxiliary Input - External Connector 

The external stereo auxiliary input connector is located in the center of the three : 
jacks on the card's bracket (refer to Figure 1, No. 8). This connector lets audio sigi 
from a stereo source (such as a CD player, CD-ROM drive, synthesizer or cassette 
player) to be mixed with the other audio sources or to be used as a source for samJ 
sounds. 

' • 
WARNING: To avoid distortion, it is important to keep the 
audio level of the device you are connecting to this input jack 1 

low volume and to adjust the volume using the software 
controls explained in the next section. Also, make sure that yo 
are using the auxiliary output of the device you are connectin. 
to the card, instead of using the speaker output which would 
overload the card's amplifier. 

Stereo Auxiliary Input - Internal Connector 

As mentioned in the "Description of the Hardware: Layout of the Card" section, th1 
an internal connector (refer to Figure 1, No. 4) for connecting the audio output of : 
internal CD-ROM drive. This connector is electrically in parallel with the external 
stereo auxiliary input connector. Thus, to obtain good sound results, you may only 1 

one of these at a time. 

MIDI/Game Port 

The Ad Lib Gold card features a standard DB-15 connector at the bottom of its 
supporting bracket (refer to Figure 1, No. 10). This connector lets the user connecl 
of the following three options: 

1. An IBM compatible joystick. 

2. A MIDI device. (This requires the Ad Lib MIDI Pak.) 

3. Dual joystick. (This requires a special adapter, which is usually supplied by tt 
joystick manufacturer. - See Figure 4 for related jumper settings.) 
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tware Installation and Configuration 
unning and using of the Ad Lib Gold card drivers and programs require hard disk 
, of approximately 5 megabytes. They must be installed onto the hard disk 
ring a precise procedure. For this purpose, the Gold software package includes a 
11 Setup program. This program enables you to install the drivers and all 
iated programs, to configure your Ad Lib Gold card and to change the hot keys 
by Mixer Panel and ROL2 Playback TSRs. 

g the Setup Program 
,d Lib diskettes are not copy-protected. We recommend that you make a back-up 
before installing Gold software. Put the originals away in a safe place. This way, if 
lette is lost or damaged, you will have a replacement. We suggest that you use the 
COPY command. (For all details concerning the copy commands, refer to your 
manual.) 

lad the Setup Program 

oad the Ad Lib Gold Setup Program: 

Insert the Ad Lib Gold disk 1 into the floppy drive. 

Set the current drive to A ( or B, depending on the drive you are using). 

Load the Setup program by typing the following command at the DOS prompt: 

A : \>setup 

1 the program opens, a window entitled "Installation Notes" introduces you to the 
J Program and its basic commands. To activate a command, use one of the 
1ving methods: 

Using the Tab key: Scroll and choose the command you want with the ''rabJ or 
lr-0 l \'Tab] keys, 

Using the keyboard shortcuts: To activate the command you want, press the 
, Alt j key and the letter highlighted in its name. 

Using a mouse: To activate the command you want, click on it with the mouse. 

main buttons are displayed at the bottom of each screen: <Cancel> and 
1tinue>. 

rating the <Continue> button in the Installation Notes introductory screen makes 
letup program open the Main Selection menu (see Figure 5). 
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Ad Lib Gold Setup Progron 
~ain Selectio 

For a first-th1e installation you 111Ust first copy the progra111s and T 
driuers to your hard disk. 

You should then configure the Ad Lib Gold card . ! 
Please select an installation procedure: 

< 1 - Copy Progra111s and Driuers to Hard Disk > 

< 2 - Configure the Card aod Dr i uers ) 

< 3 - TSR Hot Keys ) 

< 1 - Quit the Setup Progr•• ) 

< Cancel > 

Figure 5: Setup Program's Main Selection menu 

This menu lets you choose and access the four following submenus: 

1. Copy Programs and Drivers to Hard Disk 

2. Configure the Card and Drivers 

3. TSR Hot Keys 

4. Quit the Setup Program 

To Cancel the Setup Process 

At any moment, you can interrupt the setup process by clicking on the <Cancel> 
button at the lower left corner of the screen, or by pressing the ~ key. Doing this 
will abort the setup and cancel the steps you have made. The changes you made are 
saved in permanent memory on the card. When you reboot your system, these chang 
will not be restored. So, if you have a problem after making a change, just reboot yot 
system. 

~ NOTE: Certain elements cannot be reversed and will remain 
installed, such as copiedfiles. To cancel the entire operation, it 
is necessary to re-run the Setup Program and reverse the 
corresponding steps, or delete the copied files. See Appendix B 
for a list of the installed files. 
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ontinue the Setup Process 

e setup process, activating the <Continue> button lets you close the current 
g box and access the next step. Doing this will initiate the changes you made in 
lialog box, if there were any. 

nswer Program Questions 

1g each step of the setup procedure, you will be asked to choose between different 
ns or to enter answers in edit fields. The program suggests an answer that will be 
,ct in most situations. You can use this default, or enter your own answer. 

tiguration Environment Variables 
:cial environment variable, called "GOLD" is used by the software to recognize the 
address of the Gold card. When the card is relocated by the Setup program, the 
:am automatically modifies the environment variable in the AUTOEXEC.BAT file. 

1ange the GOLD environment variable, type the following command, which should 
·eferably put in the AUTO EXEC.BAT file: 

SET GOLD= xxx 

·e xxx is the hexadecimal value of the Gold card base address (Control chip 
ess). 

1 the GOLD environment variable is not defined, the programs assume a default 
address of 388H. 

her environment variable, called "GOLDPATH" is used by some software (the 
l Playback TSR, for example) to determine the location of the data files ( .SMP, 
:). 

iange the GOLDPATH environment variable, type the following command, which 
Id be preferably put in the AUTO EXEC.BAT file: 

SET GOLDPATH = pathl;path2; ... 

:e pathl and path2 are directories where data files can be found. 

rr the GOLDPATH environment variable is not set, the applications look for the 
files in the directory they were started from. 
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Testing the Hardware 
The Ad Lib Gold Test program, which is supplied with the Gold software, enables yo 
verify that the Gold card is functioning properly. These tests are not only used to te1 
the Ad Lib hardware, but also to test the connections to all associated peripherals 
(MIDI ports,joystick, CD-ROM, etc.). 

Preparing the Test Program 
Prior to running the Test Program: 

1. Make sure that the Gold card is properly installed. If necessary, refer to the 
section "Installing the Hardware". 

2. Connect headphones, a speaker or stereo system to the audio jack. 

3. Connect the peripherals you plan to use with the Gold card. 

4. Turn on your computer. If it is already on, we recommend resetting it. 

Loading the Test Program 
To load the Test Program: 

1. Make the directory where you placed the Gold software the current directory. 
For example: 

C:\ >cd gold 

2. Load the Test program by typing the following command at the DOS prompt: 

C:\GOLD>test 

When the program opens, a first window entitled "Installation Notes" introduces yo1 
the Test Program and its basic commands. Two main buttons are displayed at the 
bottom of each screen: <Cancel> and <Continue>. 

Before each test, the program will explain what the test does. It will also point out t 
procedure to follow to complete the test. This information is shown at the top of eac 
test screen. To see the whole text, click on the scroll bar with the mouse, or select ti 
scroll bar with the [[Tub) key and use the vertical arrow keys ( i1] and li) ). 
If a test does not succeed, a message will appear giving probable causes and solutio1 

To Continue the Test 
The <Continue> button lets the user access the next step of the test. 

To Cancel the Test and Exit the Program 
When all tests are finished, or anytime within the test procedure, you can exit the T1 
program and return to DOS by activating the <Cancel> button. 
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~sing Test Options 
ing on the <Continue> button in the Installation Notes introductory screen opens 
election Panel dialog box (see Figure 6). This dialog box presents the list of the 
you can execute: 

Configuration 

Audio 

CD-ROM Interface 

Timers 

FM Sound 

• Joystick 

• MIDI Interface 

• Sampling and Playback 

• Mixer 

, of these options may be grayed to indicate that they are disabled depending on 
vailable hardware. Checking off any of these check boxes will let you access the 
sponding tests. 

1ptions can be selected by using one of the following methods: 

Using_!he _Iab key: Scroll and choose the option you want with the Tab key ( [!Tut>) 
or 1:£.J !1Tab)) or the arrow keys ( 9 or cj ). 
Using the keyboard shortcuts: To select the option you want, press the TATO key 
and the letter highlighted in its name. 

Using a mouse: To select the option you want, click on it with the mouse. 

Ad Lib Gold Test Progra• 
Selection Panel 

The Test Panel dialog box presents a list of the tests you can d0. ; 
Select as 111any tests as you want and then click on the < Continue > 
button. 

ili1 ..! 
l 

[ l 1 - Configuration [ l 6 - Joystick 

[ 12-Audio r l 7 - "IDI Interface 

[ l 3 - CD-ROM Interface [ l 8 - S.•pling and Playback 

[ J 1 - Th1ers 

[ ]5-Fl1Souncl [ l " - "ixer 

< Caocel > < Contiooe > 

Figure 6: Test Program's Selection Panel 
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Select the option you wish to test and then activate the <Continue> button. You cai 
also test several options in a row by selecting the options you want and activating th 
<Continue> button. Any test can be executed more than once if desired. 

Each test panel displays information on the test currently being performed and 
describes the problems and solutions which may be encountered during the test. 
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Mixer Panel TS 
The Ad Lib Gold card has an on-board analog mixer that permits the volume of 
different audio sources to be controlled, as well as overall output volume, balance a1 
tone. These features can be accessed using the Mixer Panel TSR. 

The Mixer Panel TSR is a program that allows you to set the different sound parame 
of the Ad Lib Gold card at anytime and from within any application. This memory 
resident program includes three different control windows: 

l. Sound Parameters 

2. Sub Mixer 

3. Surround Features 

? • 
TSR stands for Terminate-and-Stay Resident program, which ii 
also called memory resident program. It is a utility program 
designed to remain in the computer's memory at all times after 
loading so the user can activate it with a keystroke at any time, 
even while running another program. For more information or. 
TSRs, see Appendix D. 

Loading the Mixer Panel TSR 
To load the Mixer Panel TSR, set the current directory to the one where you placed 1 

Mixer Panel at installation and type the following command: 

mixer 

~ NOTE: This command can be placed in a batch file so that it is 
loaded automatically. See your DOS user guide for details. 

When the program is loaded, it will display a message indicating that the program h; 
been successfully loaded. It will also indicate which keys must be used to activate th 
Mixer Panel. 
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Mixer Panel window will not open upon loading and has to be activated as 
ained in the next section. If you want the Mixer Panel window open upon loading 
irogram, you can use the option "/a" with the loading command. To do this, go to 
1ppropriate directory and type the following command at the DOS prompt: 

mixer /a 

tivating the Mixer Panel 
] @:] i]l are the default activation keys. (In order to avoid conflicts with other 
:rams, you may change the last key in the combination of keys used to activate the 
ir Panel by using the Setup program.) To activate the Mixer Panel, press all of the 
ration keys down at the same time and release them. Upon releasing the keys, the 
1 Mixer Panel window will appear as shown in Figure 7. 

TSR can be activated at any time with applications supporting the Ad Lib Gold. 
screen will be returned to its original state and mode when you exit the Mixer 
sl window. 

~ NOTE 1: If you use a Hercules card with a MGA monitor, the 
Mixer Panel can be activated only in text mode. If you activate 
the Mixer Panel while in graphics mode, this may cause 
problems with your system. 

NOTE 2: The Mixer Panel cannot be activated in some appli­
cations which bypass the use of the PC's ROM BIOS to use the 
keyboard. For this reason, the Mixer Panel cannot be activated 
in a number of computer games, for example. 

ing the Mixer Panel 
h window of the Mixer Panel displays the different parameters and options of the 
l card ( see Figure 7). To set one of these: 

Select the item you want using the vertical arrow keys ( [TI and [fJ). 

After this, you can modify the chosen item in one of the following ways: 

• decrease or increase the numerical parameters and option words one step at a 
time using the horizontal arrow keys ( IEJ and [B ); 

• decrease or increase the numerical para-meters ten steps at a time using Shift 
with the horizontal arrow keys c [ o I El and @ J rr::3); 

• toggle On/Off parameters using the Space bar. 
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Sound Parameters 
When the program is activated, you will see a window appear for setting the basic 
sound parameters of the Gold card. 

Ad Lib Gold 
Mixer Panel 

69 Volurrie 
Balance 
Treble 
Bass 
Input level 
Output 111ode 

50 - 50 
40 
40 
49 

Linear 

<Fl-MSC rriode> <F2-Sub Mixer> 
<F3-Surround) <F4-Save> <OK> 

Figure 7: The main Mi,xer Panel window 

Volume 
Sets the master output volume of the board. 

Balance 
Sets the relative volume of the two stereo channels. Setting the right channel will 
automatically set the left channel; when you increase the right by one unit, the left 
channel decreases by one unit, and vice versa. 

Treble 
Sets the relative loudness of the high frequencies of the sound. 

Bass 
Sets the relative loudness of the low frequencies of the sound. 

Input level 
Sets the gain (input level) of the external auxiliary source and of the microphone. 

Output mode 
Sets the output mode of the audio source to one of four options: 

• Linear: without any effect on the audio source; 

• Pseudo: pseudo stereo effect that can be applied when the source is mono; 

• Mono: forced mono effect that can be applied when the source is stereo; 

• Spatial: light surround sound effect that can be applied when the source is ster 
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default setting is Linear. 

- MSC mode/Gold mode> 

Mixer Panel l'SR 
Using the Mixer Panel 

its the Gold card so it is compatible with the original Ad Lib Music Synthesizer 
I. This might be necessary in cases where a third party application that does not 
,erly put the Gold card in its default mode for full compatibility with the original 
,ib card. 

:-S ub Mixer> 

ns the Sub Mixer window. 

I-S urround> 

ns the Surround Features window (when using the add-on Surround Sound 
ule). 

I-Save> 

ns a dialog box that allows the current configuration of the Gold card to be saved in 
nanent memory. The saved configuration will be in effect when you power on the 
puter. 

Ad Lib Gold 

The current Mixer Panel values 
will be saved in pernanent 
nenory. Type (OK> to proceed, 
or <Esc) to abort. 

<OK> <Esc) 

·=·=·=•:•:•: •: •:•:•:•:•:•:•: •:•: •: •:• :• :•:•:•: •:• :•:•: •:•:•:•:• :, :-:-:• :• :•:•: •:•:•:•:•:,:.:,:- :•:• :• :•:•:•:•:• :•: •!•:•:•: •:•:•:•:•: •::: 

Figure 8: The Save dialog box 

K> ff Enter] or ~) 
ses the Mixer Panel main window and returns to the current application saving the 
.nges you made in the settings. 
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Sub Mixer 
Activating the ~ key when in the Mixer Panel main window will open the Sub Mix 
control window. Sub Mixer parameters allow the output volume from the five differe 
audio sources to be controlled: 

FN 
Sa..,pl ing 
Auxiliary 
Nicrophone 

Sub Nixer 

100 
100 
100 
100 

<OK> 

<<<<<<<?:::t?'?':>:tt/' >>>><<<<<<<<<>Ji: 

Figure 9: The Sub Mixer control window 

FM 
Sets the output volume of the FM source. 

Sampling 
Sets the output volume of the Sampling source. 

Auxiliary 
Sets the output volume of the auxiliary source ( external or internal). 

Microphone 
Sets the output volume of the microphone. 

<OK> ( ffEnterJ or i~) 
Closes the Sub Mixer control window and returns to the main Mixer Panel window 
saving the changes you made in the Sub Mixer parameter settings. 

Surround Features 
Activating the ~ key when in the Mixer Panel main window will open the Surrounc 
Features control window. 
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Ad Lib Gold 

Surround Features 

Surround 
Level 
Effect 

On 
90 

Recital Hall 

Figure 10: The Surround Features control window 

~ NOTE: If the Surround Sound Module is not installed, the 
program will display the message "OPTION NOT INSTALLED" 
and the changes you make to the parameters will have no effect 
(Fig. 11). 

Tound 

Ad Lib Gold 

Surround Features ,,,, 
i=== 

I;;:rd Redtal H:fi ::: 
-- OPTION NOT INSTALLED -­

<OK> 

:'.::':'_:::.'_.:::'.::'.'..:.'::::.::::.:::::::.::.::.:.: .. :::::':.:'::::.::':':' .. :'::::: .. :::.:.:: ':':':':'.:':':':':':':':':':'.:';;:; 
<F3-Surround) <F4-Saue) <OK> 

Figure 11: The Surround Features control window 
when option not installed 

Jgg!e On/Off allows the Surround Sound option to be enabled or disabled. The 
ault setting is Surround Off. 
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Level 
Sets the level of the surround sound effect produced by the Surround Sound Module. 

Effect 
Sets the type of surround sound effect you want to enhance the sound ambience 
selected from a variety of presets. 

<OK> ( '. Enter] or B) 
Closes the Surround Features control window and returns to the main Mixer Panel 
window saving the changes you made in the parameter settings. 

Hot Keys 
You can use three combinations of keys to set the master volume and to turn On and 
Off the Surround Sound at any time, without opening the Mixer Panel window. The 
program default hot keys are the following: 

11 AITJ /◊] ill] Increases the master volume one unit at a time. 

17.Jfl l':fr] @) Decreases the master volume one unit at a time. 

~m llTI [ID Enables and disables the surround sound effect. 

In order to avoid conflicts with other programs, you may change the last key in the 
default combinations of keys by using the Setup program. 

Closing the Mixer Panel 
When in the main window of the Mixer Panel, press the l[E~ter] or ~ key to leave th, 
program and return to where you were when the Mixer Panel was activated. 

Removing the Mixer Panel TSR 
When the Mixer Panel TSR is already installed but you do not wish to use it, you can 
unload the program with the option "/ r". This option removes the Mixer Panel TSR 
from the computer's memory. To remove the Mixer Panel TSR, go to the appropriate 
directory and type the following command: 

mixer /r 

Once this command is entered, the program will display a message indicating that the 
Mixer Panel has been removeii. 
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Juke Box Gold Musi 
Playback Progra~ 

Juke Box Gold is a music playback program specially designed to demonstrate the 
sound capabilities of the Ad Lib Gold card itself. It enables you to play pre-programm 
songs, or those you create yourself using the Visual Composer Gold music compositio1 
program (sold separately). Selected songs can also be played at any time while other 
applications are running, with the use of the ROL2 Playback TSR commands. 

Loading Juke Box Gold 
To load Juke Box Gold, set the current directory to the one in which you placed Juke 
Box Gold at installation and type: 

jukegold 

Once the program is loaded, the main Juke Box Gold window will appear as shown in 
Figure 12. 

Juke Box Go Id 
Options Help 

Directory E:\DEl10 

BUILDGLD .HL2 E: \DEltO\GERIIYO . RL2 
AVEGLD.RL2 <Select> E :\DEltO\MCHIGLD. RL2 

ERAGLD.RL2 E: \DEltO\POWER2GD. RL2 
FLIGHTGD .RL2 (Re,wue) 

~UGUE2.RL2 
CERRYO.RL2 
HIIIAYGD2 .RL2 
INDUSGLD. RL2 
MRAXENGD . RL2 

ORDGLD.RL2 
~UTECON. RL2 
~ACHIGLD .RL2 

Currently playing: 

<Play> <Pause ) <Stop> (Next> (Previous) 

Volu111e Treble Bass 

Figure 12: The main Juke Box Gold window 

This window displays the various menu titles and command buttons (see Figure 12). 
Other possible options are contained in the menus. To activate a menu or command, 
use one of the following methods: 
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l. i£nJ the Tab key: Scroll and choose the command you want with the l[Tab I or 
-0 i[fa51 keys. 

l. Using the keyboard shortcuts: To activate the menu or command you want, press 
the ii Alt I key and the letter highlighted in its name. To activate a command in an 
open menu, press the highlighted letter. 

l. Using a mouse: To activate the menu or command you want, click on the menu or 
button command with the mouse. 

electing Songs 
reating a Selection of Songs 
1e main Juke Box Gold window contains two large boxes for song selection. The box 
cated at the left of the screen displays the contents of the current directory. This is a 
,t of files, subdirectories and drives through which you can navigate by selecting a 
Lme and pressing the [[Enter] key, or by double clicking with the mouse. The name of 
e current directory is displayed above the box. When the program is loaded, the 
,fault directory is the directory where you placed Juke Box Gold. 

> create a selection of songs, go to any directory containing ROL2 files, highlight the 
e and activate the Select command, or press [EntefJ , or double click with the mouse, 
r each song you wish to add to the selection. As each song is selected, its DOS file 
Lme will be displayed in the Selection box at the right of the screen in its order of 
lection. You may select as many songs as you wish ( depending on memory capacity), 
1t only from a single directory. 

[) Remove Songs from the Selection 
1e box at the right of the screen displays the list of songs contained in the selection 
,u have made. To remove a song from the selection, highlight its name and activate 
.e Remove command. 

[) Clear a Song Selection 
i remove all the songs contained in the selection at once, simply choose the Clear all 
,mmand from the Options menu. 

'laying Music 
o Play Songs 
) play your selection of songs, activate the Play button. Each song in the list will be 
ayed in order. 

nee the music begins playing, the name of the song currently playing is displayed at 
1e bottom of the window. 
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To Stop Music Playback 
To stop music playback, activate the Stop button. 

To Pause and Resume Music Playback 
To pause music playback, activate the Pause button. When the music pauses, the Pau 
button toggles to Resume. 

To continue music playback at the exact place where it stopped, activate the Resume 
button. Once the music starts up again, the Resume button switches back to Pause. 

To Scan Songs 
To skip to the next song during playback, activate the Next button. This will 
immediately start the next song if there are any left in the song selection list. 

To return to the previous song during playback, activate the Previous button. This wil 
immediately start the previous song. 

Adjusting the Sound 
The Ad Lib Gold card has an on-board analog mixer that allows volume and tone 
controls to be adjusted. These features can be accessed from any application by using 
the Mixer Panel TSR program (see the section "Mixer Panel TSR"). But you can also 
adjust the sound directly inside the Juke Box Gold program. Three sliders located alo 
the bottom of the window allow you to adjust volume, bass and treble controls while 
listening to Juke Box songs. 

To Adjust the Volume, Bass or Treble 
To adjust one of these three parameters, activate the slider you want and use the left 
and right arrow keys ( ~ and ~) to lower or raise the value of the chosen 
parameter. You can also scroll the indicator inside a slider with a mouse. 

To Set the Stereo/Mono Option 
The Gold card output can be set either to stereo sound ( distinctive signals for the left 
and right channels) or mono sound (identical signals from both channels). To change 
from one to the other, choose the Stereo or the Mono option from the Options menu. 

Asking for Help 
When you choose the Help command from the Help menu, a window opens up on the 
screen containing summarized information on how to operate Juke Box Gold and how 
to use the various features. 
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iting the Program 
eave the program and return to DOS, use one of the following methods: 

Activate the Exit command from the Options menu. 

OR 

Click on the System menu box at the upper left corner of the window and activate 
the Close command. 

:ing the ROL2 Playback TSR 
music files played by Juke Box Gold are called ROL files (.ROL or .RL2). In order 
lay these music files, the application uses a TSR driver, which we refer to as ROL2 
1back TSR (see Appendix D for more information on TSRs). 

:e TS Rs stay in memory while we use other programs, the ROL2 Playback TSR 
ws you to play the songs previously selected in Juke Box Gold, while using other 
lications. 

details on the loading options of the ROL2 Playback TSR, see "Appendix D: 
·ers / TS Rs". 

playback commands of this TSR can be used at any time by the following key 
binations: 

Ail) ''i) · 1 J:J Plays the selected songs. 

· Alt j ~ ~ Pauses and resumes the music playback. 

'Alt ] .TI !CT] Stops the music playback. 

·Alt] ·0 J •L!iJ Skips to the next song from the selection. 

· Alt J ~ M Returns to the previous song from the selection. 

rder to avoid conflicts with other programs, you may change the last key in the 
bination of keys used to activate the above commands by using the Setup program. 

min Juke Box Gold, you should preferably use the program playback commands 
ead of the TSR playback commands. 

WARNING: Do not use the ROL2 Playback TSR while running 
other music applications, as this will cause conflicts with the 
ROL2 Playback driver. 
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Voice Pad Record an 
Playback Progra1 

Voice Pad is an Ad Lib Gold program that enables you to record, edit, manage and pl 
back your "voice notes". A voice note can contain the following information: 

• recorded digitized sounds, which are usually vocal notes entered by the user; 
• a brief written comment added to a vocal note; 
• an alarm time, which is used to trigger a later playback of a note. 

Voice notes can be heard using the Playback command within the Voice Pad prograr 
or automatically by a memory-resident section of the program (Alarm driver) which 
will play back voice notes at the time specified in the voice note description. Voice 
notes can be played back daily, at a specified time ("Daily Alarm"), or played back o 
once at a specified date and time ("Date Alarm"). Voice notes with alarms will be 
played back, even while other applications are being used. 

Loading Voice Pad 
To load the Voice Pad program, set the current directory to the one where you place, 
the Voice Pad program during installation, and type: 

voicepad 

When the program is loaded, the main Voice Pad window will appear as shown in 
Figure 13. 

Ad Lib Voice Pad 
File Sa•pling Options Help 

Name: [Untitled l 
Actual Ti•e: 
18:28:16 a• 

Snooze: 15 1 rrlinutes 

Note: I I 

lar,,, :.ecord 

( •) Standard MellO - < Play ) 

( ) Daily alar• 

( ) Date alaro 
Record time: 

Alarll'I ti111e: IHH:MMJ I I po 
8. 08 seconds 

Alar• date: IYY1MM1DDl 

Figure 13: The main Voice Pad window 
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window displays various menu titles, command buttons, options and edit fields. 
·e are other possible commands contained in the menus. To activate one of them, 
me of the following methods: 

Using the Tab key: Scroll and choose the command or edit field you want with the 
'fab] key or ◊ I 'rab) keys. 

Using the keyboard shortcuts: To activate the menu or command you want, press 
the · Alt j key and the letter highlighted in its name, or press the appropriate 
function key; to activate a command in an open menu, press the letter highlighted 
in its name. Special shortcuts for the File commands are also displayed in the File 
menu. 

Using a mouse: To activate the menu or command you want, click on the menu or 
button command with the mouse. 

cording a Voice Note 
Record a Voice Note 
Activate the Record command. The Record button will then toggle to Stop. 

Immediately enter the message you wish to make, speaking not too far from the 
microphone (maximum of approximately one foot). 

Stop the Recording 
top the recording, if the recording time has not run out, activate the Stop 
mand. The Stop button will then return to Record. 

tting the Recording Parameters 
Set the Recording Time 
default recording time is 10 seconds. To change the recording time, activate the 
1pling Duration command from the Sampling menu and enter the desired number 
iconds from 1 to 999. 

Set the Sampling Rate 
sampling rate is the number of sound samples per second the program takes. The 

1er the sampling rate (and the higher the bit resolution), the higher the quality of 
recorded sounds (and the higher the amount of disk space required to store the 
:e note) . 
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You can change the sampling rate to adjust the sound quality and amount of disk sp: 
your voice note uses. The default sampling rate is 11.025 KHz. To change the sampli1 
rate, open the Options menu and choose one of the displayed sampling rates. To set 
recording compression mode, open the options menus and select either ADPCM 
compression or no compression. 

To Set the Microphone Gain 
To set the microphone gain: 

1. Activate the Mixer Panel. 

2. Using the vertical arrow keys ( l1}, [1) ), choose the Input level parameter. 

3. Using the horizontal arrow keys (IE], B ), lower or raise the value of the lnJ 
level, which ranges from Oto 100 with a default setting of 49. We suggest you 
adjust the volume of your recording by proceeding as follows: 

• Make a first recording at the default Input level of 49. 

• Activate the Playback command to listen to the sound quality of the 
recording. 

• If the sound is distorted, decrease the Input level (and/or speak at a greate 
distance from the microphone) and start again. If the sound is too weak, 
increase the Input level ( and/or speak at a shorter distance from the 
microphone) and start again. 

• Repeat the procedure until you are satisfied with the volume of the recordi 

? • 
The microphone gain is the input level of the microphone. This 
parameter directly affects the overall volume of your recording. 
A gain set too low will give a recording weak in volume and 
possibly full of parasitic noise. A gain set too high may 
introduce distortion into the recording. 

Listening to a Voice Note 
To Listen to a Voice Note 
To listen to a voice note, open the voice note (see below "To Open an Existing Voice 
Note") and activate the Play command. The Play button will then toggle to Stop. 

To Stop the Playback 
To stop the playback at anytime, activate the Stop command. The Stop button will th 
switch back to Play. 
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naging Voice Notes 
1 you create a voice note, the digitized recording is stored independently in a .PAD 
'or each voice note created, other basic information ( description parameters, 
1s, written comment, etc.) are stored in a bank file, which contains information on 
ection of voice notes. 

Pad only recognizes the bank file named DIRVOICE.PAD. This file is not 
Jred with Voice Pad. The first time you save a voice note, the program will 
natically create the DIRVOICE.PAD file to store your voice note. From then on, 
dditions and modifications of voice notes will be written to DIRVOICE.PAD. 

l'. NOTE: DIRVOICE.PAD bankfile must remain in the same 
directory as the Voice Pad program (VOICEPAD.EXE)for it to 
work properly. The digitized recording .PAD Jiles can be placed 
in any directory. 

:ommands used for managing voice notes are found in the File menu. You will use 
, commands often, whether you are saving your work, opening a new voice note, 
1g, or deleting a previously saved voice note. 

ng a Voice Note 
to storing a newly recorded voice note, you must first name it. To save a voice 

Select the Name edit field . 

Enter the name you wish, to a maximum often characters. 

Activate the Save command from the File menu. 

l voice note has already been named, it will automatically be saved. If not, the 
:am will save it by default under the name "Untitled" in the bank. 

1ting a New Voice Note 
·eate a new voice note, activate the New command from the File menu. This 
nand will close any open voice note and will open an empty and untitled voice 
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To Open an Existing Voice Note 
To open an existing voice note: 

1. Activate the Open command from the File menu. A dialog box appears on the 
screen listing all the voice notes in the bank. 

2. Select a voice note from this list. 

3. Activate the Open button to confirm your choice. This command will close ani 
open voice note to make room for the new one. 

To Delete a Voice Note 
To delete a previously saved voice note: 

1. Activate the Delete command from the File menu. A dialog box appears on thi 
screen listing all the voice notes of the bank. 

2. Select a voice note from this list. 

3. Activate the Delete button to confirm your choice. This command will 
automatically delete the chosen voice note in the bank. 

Setting the Alarm 
Voice Pad has a built-in alarm clock which allows you to set a date and time at whic 
start playing a given voice note. 

To Set a Daily Alarm 
If you set a daily alarm for a voice note, the recorded message will start playing at ti 
specified time on every day. To set a daily alarm: 

1. Choose the Daily Alarm option in the main window. 

2. Activate the Alarm Time edit field. 

3. Enter the hour and minute using the appropriate format. 

Doing this will automatically create a "DLY'' type voice note. 

To Set a Date Alann 
If you set a date alarm for a voice note, the recorded message will start playing at th 
specified time on the specified date. 

To set a date alarm: 

1. Choose the Date Alarm option in the main window. 

2. Activate the Alarm Time edit field. 

3. Enter the hour and minute using the appropriate format. 
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Activate the Alarm Date edit field. 

Enter the date you wish using the standard format (year/month/day), as shown in 
parentheses. 

\ this will automatically create a "DTE" type voice note. 

~ NOTE: If you do not use the alarm option, or if you choose the 
Standard option, this will create a "STD" type voice note. 

et the Snooze Option 
Pad offers a Snooze option that allows a voice note with alarm to be repeated 

ving a time delay chosen by the user. The Snooze ensures that you will not miss a 
note message, in the event you are gone while the alarm is playing. 

t the Snooze time delay for a voice note: 

Activate the Snooze edit field located in the middle of the main window. 

Enter the desired time for the delay between the voice note repetitions, from O to 
60 minutes. If you do not need snooze, enter a time of 0, which means the voice 
note has no snooze setting. 

1 want to stop an active snooze repetition, proceed as follows: 

Activate the Stop Snooze ... command from the Options menu. A dialog box opens 
displaying a list of all currently snoozing voice notes. 

Highlight the voice note you want to stop snoozing. 

Activate the Stop Selection command. 

You can also activate the Stop All command to stop all snoozing messages at once. 

1, NOTE: Snooze is only effective for one day. Message repetitions 
will stop at the moment the system date changes. 

'ollowing gives summary information about the three types of voice notes Voice 
!reates depending on the alarm you specify: 

"STD" type, or Standard, voice notes: 

• No alarm has been specified. 

• Voice note will not be played. 
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2. "DLY'' type, or Daily, voice notes: 

• Daily alarm has been specified. 

• Voice note will be played daily at the time specified. 
• Voice note will be repeated until the date changes, according to the time 

delay specified in the Snooze setting. 

3. "DTE" type, or Date, voice notes: 

• Date alarm has been specified. 

• Voice note will be played at the date and time specified. 

• Voice note will be repeated until the date changes, according to the time 
delay specified in the Snooze setting. 

To Change the Time Fonnat 
The 12 hour clock is the default format used for the alarm. You can change the tim, 
format by opening the Options menu and selecting the "24 Hour Clock" or the "12 ~ 
Clock" option. 

The actual time is displayed in the box at the upper right corner of the screen in th 
chosen time format. 

Setting the Voice Note Display Options 
The option DISPLAY, located at the top right of the Open and Delete dialog boxes, 
allows you to display the following three categories of voice notes: 

• All types of Voice Notes: "STD", "DLY'' and "DTE"; 

• Daily Alarm voice notes only: "DLY''; 

• Date Alarm voice notes only: "DTE". 

The option SORT, located at the bottom right of the Open and Delete dialog boxes, 
allows the displayed voice notes to be sorted in one of the following four ways: 

• By Record Date 

• By Alarm Date 

• ByName 

• BySize 
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Jing a Written Comment 
an also add a brief written comment to your voice note. To do this: 

Activate the Note edit field in the main window. 

Enter the text you want to a maximum of 51 characters. 

Nritten comment will be displayed each time you open the voice note. 

justing the Sound 
td Lib Gold card has an on-board analog mixer that allows volume and tone 
'01s to be adjusted. These features can be accessed in the Mixer Panel TSR, if it is 
lled. Upon opening the Mixer Panel, you can set the different sound parameters, 
as input level, overall output volume, balance, treble and bass. For complete 
mation, consult the section "Mixer Panel TSR". 

king for Help 
1 you choose the Help command from the Help menu, a window opens up on the 
rn containing summarized information on how to operate the Voice Pad and how to 
ts various features. 

ting the Program 
e in the main window of Voice Pad, activate the Exit command from the File menu 
ess :·c1r1J r·~ to leave the program and return to DOS. Before this command is 
ed out, a dialog box appears to ask if you wish to save the changes you have made 
ur active voice note, if there were any. 
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Using the Alarm Driver 
The Voice Pad program uses three memory resident drivers that are necessary fort 
playback of voice notes. The executable files for these drivers are CTRLDRV.EXE, 
WAVEDRV.EXE and ALARMDRV.EXE. These drivers must be loaded into memory tc 
allow voice note alarms to be played. When you use the Voice Pad program, you do 1 

have to load these drivers separately. The program has a batch file that automatica 
loads these drivers. If you do not wish to use the application program, you can load 
drivers independently by typing the following commands at the DOS pr_ompt: 

drivers 

alarmdrv 

~ NOTE: It may be advi,sable to load these drivers from the 
AUTO EXEC file, so that they are loaded automatically when yo 
start the computer. Place the contents of the DRIVERS.BAT file 
and the ALARMDRV command into the AUTOEXEC.BAT file. Se, 
your DOS user guide for details. 

r. For more iriformation on drivers, see "Appendix D: Drivers I TSRs". 
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Soundtrack Synchronization Edi1 
Soundtrack Synchronization Editor is an Ad Lib Gold program that allows you to m 
and synchronize pictures created with a graphic or animation program using the 
various audio sources of the Gold card: FM synthesized music, digitized samples (v 
and/or sound effects) and CD audio. 

Loading Soundtrack Sync Editor 
To load the Soundtrack Synchronization Editor, set the current directory to the on• 
where you placed the program at installation, and type the following command: 

stracked 

When the program is loaded, the Soundtrack Sync Editor will appear as shown in 
Figure 14. 

Ad Lib Soundtrack Syochronization Editor 
File Edit Pl•y Options Help 

-Picture~ ·- - lnfomation-

D LJ 
File Naoe:UNTITLED.SNC 

Cue Na.111e :[ 1 
Cue TiMe :[ l 

Clock :00:00 .0 

;';usic .------Sa111ple- ~D Audio~ 
FHEE FHEE FHEE 

Naoe :[ 1 Naoe :[ 1 Tr•ck :[ l 
Start :[ l sec St•rt :[ 1 sec Start :[ J sec 
Stop :[ 1 sec Stop :[ 1 sec Stop :[ J sec 
Fade In :[ 1 sec Fade In :[ ] sec Fade In :[ 1 sec 
Fade Out :[ 1 sec Fade Out :[ 1 sec Fade Out :[ 1 sec 
Uolu.e :[ l UoluMe :[ I Uolune :[ l 

I I ltute (") I I ltute CS) I 1 "ute CC) 

Figure 14: The Soundtrack Sync Editor 

Using the Soundtrack Sync Editor 
When the program opens, you will see a window displaying the different boxes, opti, 
and edit fields (see Figure 14). There will also be commands in menus at the top of 
screen. The various program features can be used as follows: 

1. Using the Tab key: Select the edit field or command you want with the ·Tab) • 
or {{} ] lrati] keys. 
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You can then enter the requested data or press l'Enter] to activate the selected 
command. 

Using the vertical arrow keys: Select the name you want in a scroll list, or a 
command in an open menu with the J] key or the 1) key. 

Using the left and right arrow keys: Position the cursor where you want in an edit 
field, or move from an open menu to another with the •~ key or the 8 key. 

Using the keyboard shortcuts: To activate the menu or option you want, press the , 
key and the highlighted letter simultaneously, or press the corresponding 
function key. To activate a command in an open menu, press the letter 
highlighted in its name. Special shortcuts for the File commands are also 
displayed in the menu. 

Using a mouse: To activate a menu or command, or select an edit field, click on it 
with the mouse. 

out the Sync Files 
Ad Lib Soundtrack Synchronization Editor is for creating, editing, managing and 
ng .SNC - or Sync - files containing one or several cue descriptions. A cue is a 
en moment of time at which you want one or more events to start. For multimedia 
ications, cues link sound and music from various audio sources with a picture file 
1 animation file. 

~ a Sync file is created, you may use the Ad Lib Soundtrack Playback driver or the 
,desk™ Animator Playback utility to play back your multimedia presentation with 
nusic and sound synchronized with the visuals . 

. g the Soundtrack Playback driver, sound files linked to given picture files 
matically start to play when a graphic program displays the specified pictures. 
1g the Autodesk TM Animator Playback utility, sound files linked to given animation 
automatically start to play when the Autodesk TM Animator program displays the 

:ified animation files. (Refer to the corresponding sections of this user guide for 
1ils concerning these two utility programs.) 

e Editor Boxes 
Soundtrack Sync Editor displays three boxes at the upper part of the screen with 
rmation on the current Sync files. These are the Picture box, the Cue box and the 
,rmation box. 

:ture Box 
, box displays the names of the pictures (.PIC, .PCX, .GIF, .TIF, .BMP, .WPG, etc.) or 
nation files (.FLI) and highlights the name of the one selected. 
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Cue Box 
This box displays the names of the cues linked to the current or selected picture ar 
highlights the name of the selected cue. 

The Information Box 
This box displays basic information on the Sync file and the current cue. 

File Name 
This field displays the name of the current Sync file. 

Cue Name 
This is the edit field used to enter and display the name of the current cue. 

Cue Time 
This is the edit field used to enter and display the time (after picture loading) that 
current cue will be activated. The unit (seconds or frames) used for this field depe1 
on the picture synchronization mode specified in the Options menu (Time Mode or 
Frame Mode). 

Clock 
This is a field that displays the elapsed time of the current picture at playback or 
displays the elapsed number of frames for the current animation file, depending on 
which picture synchronization mode has been specified in the Options menu. 

Cue Parameter Boxes 
The Soundtrack Sync Editor displays three boxes at the lower part of the screen 
showing the parameters of three possible audio sources: Music, Sample and CD aud 
The following describes the parameters included in these boxes: 

FREFJUSED 
This information indicates if the sound source is active or not. 

FREE is displayed if the sound source activated at the preceding cue does not play 1 
the current cue for the same sound source. 

USED is displayed if the total length of the sound source activated at the preceding 
plays past the current cue for the same sound source. To remedy this, either increai 
the cue time for the USED sound source or decrease the Stop Time of the preceding 
cue. 

Name 
This is the edit field used to enter and display the name of the .RL2 file played in th1 
Music source or the name of the .SMP file played in the Sample source. 
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1nter a file name: 

Activate the Name edit field in the Music box or in the Sample box. 

Choose the Open ... command from the File menu, or type the shortcut · Ctrl, -~.Q] . 
A dialog box will appear listing all the files in the current directory ( on the left) 
and the drives, directories and subdirectories (on the right). The path of the 
current directory will be displayed at the top of the dialog box. 

Choose a file name from this list, or open another directory and/or drive and 
choose a file name from that directory. 

Press OK to confirm your choice. 

can also type the file name you want directly into the edit field . 

. ck 
, is the edit field used to enter and display the track number played from the CD 
lio sound source. 

rt 
s is the edit field used to enter and display the time ( after the cue) at which the 
nd source will start to play. 

p 
sis the edit field used to enter and display the time (after the cue) at which the 
nd source will stop. 

le In 
s is the edit field used to enter and display the amount of time ( after Start Time) 
r which the volume of the audio source will fade in from O to the level specified in 
Volume edit field. 

le Out 
s is the edit field use to enter and display the amount of time (before Stop time) 
r which the volume of the audio source will fade out from the level specified in the 
ume edit field to 0. 

UIRe 
s is the edit field used to enter and display the main volume of the audio source, 
ich ranges from O to 100. 
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Mute 
This is a playback option that allows an audio source to be disabled so that one or t\\ 
other audio sources can be listened to individually. Use the mouse or the Space Bar 
toggle the check box between On and Off. 

~ NOTE: This option is not saved within the Sync file. 

Elapsed Time 
This is a field that replaces the Start edit field when a selected sound source is activ 
and identified as USED. It indicates the time which has elapsed since the preceding 
cue. 

Remaining Time 
This is a field that replaces the Stop edit field when a selected sound source is activt 
and identified as USED. It indicates the time left before the sound event finishes. 

The File Menu 
The File menu contains the commands used for managing your Sync files and for 
exiting the program. These are New, Open, Save, Save AB ... and Exit. 

New 

To create a new Sync file: 

• Activate the New command from the File menu. This command will close any 
open file and will open an empty and untitled file. 

Open ... 

To open an existing Sync file: 

1. Activate the Open ... command from the File menu. A dialog box will open on ti 
screen listing all the .SNC files in the current directory. 

2. Choose a file from this list, or open another directory, subdirectory and/or drivi 
and choose a file from that directory. You can also type the file name directly ir 
the edit field. 

3. Press OK to confirm your choice. This will close any open file to make room for 
the new one. 

Save 

To resave a Sync file that has been saved before: 

• Activate the Save command from the File menu. 
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1eAs ... 

save a newly created Sync file: 

it 

Activate the Save As ... command from the File menu. 

Enter the name you want to a maximum of eight characters. Since files created by 
Soundtrack Sync Editor use .SNC as their DOS extension, it is not necessary to 
include the .SNC part of the file name. 

If necessary, change the current. directory, subdirectory and/or drive using the 
directory paths. 

Press OK to confirm your choice. The file will be saved under the name you have 
entered. 

exit the Soundtrack Sync Editor and return to DOS: 

Open the File menu. 

Activate the Exit command. 
Before this command is carried out, a dialog box will ask if you wish to save the 
changes you have made to your active file. 

1e Edit Menu 
1 Soundtrack Sync Editor allows you to modify text in edit fields with the edit 
nmands found in the Edit menu: Undo, Cut, Copy, Paste and Clear. 

Jso allows you to add and delete pictures and related cues or cues only, using Add 
ture ... , Add Cue, and Delete Picture and Delete Cue commands. 

do 

undo typing or an edit text command: 

Activate the Undo command from the Edit menu, or type the shortcut ,-0. This will 
undo the last modification you made to the text. 

cut text in an edit field: 

Highlight the text you want to cut by clicking and dragging the mouse or using 
~B or [QJ ld, 
Activate the Cut command from the Edit menu. This will remove the selected text 
from the edit field and place it in the clipboard. 
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Copy 

To copy text in an edit field: 

1. Highlight the text you want to copy by clicking and dragging the mouse or usin! 
aorf:3. 

2. Activate the Copy command from the Edit menu. This will copy the selected tei 
from the edit field and place it in the clipboard. 

Paste 

To paste copied text: 

1. Activate an edit field and position the cursor where you want the text to be 
pasted. 

2. Activate the Paste command from the Edit menu. This will paste the contents c 
the clipboard where the cursor is positioned in the edit field. 

Clear 

To clear text in an edit field: 

1. Select the text you want to clear. 

2. Activate the Clear command from the Edit menu. This will remove the selected 
text from the edit field without placing it in the clipboard. 

Add Picture ... 

To add a picture to a Sync file: 

1. Activate the Add Picture .. . command from the Edit menu. A dialog box will 
appear listing all the files in the current directory ( on the left) and the drives, 
directories and subdirectories ( on the right). The path of the current directory 
will be displayed at the top of the dialog box. 

2. Choose a picture file from this list, or open another directory, subdirectory and/ 
drive, and choose a file from that directory. You can also type the file name 
directly into the dialog box. 

3. Press OK to confirm your choice. This will add the picture file to the list. 

Add Cue 

To add a new cue to a picture: 

1. Activate the Add Cue command from the Edit menu. This will add a new cue to 
the list with the name "UNTITLED". 

2. To name the cue, activate the Cue Name edit field. The name entered must not 
contain spaces or exceed 12 characters. 
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lete Picture 

delete a picture from a Sync file: 

Select the picture in the Picture box. 

Activate the Delete Picture command from the Edit menu. 

Press OK to confirm your choice. This will remove the selected picture from the 
list and all corresponding cues. 

lete Cue 

delete a cue from a picture: 

Select the cue in the Cue box. 

Activate the Delete Cue command from the Edit menu. 

Press OK to confirm your choice. This will remove the selected cue (and all 
related sound source information) from the list. 

te Play Menu 
i Soundtrack Sync Editor allows you to play the current Sync file's three sound 
.rces back during editing. The Play menu contains the playback commands that 
iw you to listen to the Sync file you are working on. These are Play Scenario, Play 
ture, Play Cue, Pause, Continue and Stop. 

LY Scenario 

s command, which is available in Time mode only, activates all cues for the entire 
lC file. 

1y Picture 

s command, which is available in Time Mode only, activates all cues for the selected 
ture. 

1yCue 

ts command activates the selected cue. 

use 

1s command interrupts all music and sound playback in progress, but the commands, 
;ions and edit fields are unavailable (grayed out) for editing until the Continue or 
,p commands are activated. 

ntinue 

is command restarts playback of whatever was interrupted at the exact place it was 
en the Pause command was activated. 
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Stop 

This command stops all music and sound playback in progress, and the commands, 
options and edit fields become available for editing. 

The Options Menu 
Sync file playback can be done in two different modes depending on the graphic 
program used for the multimedia presentation. Choose either Frame Mode or Time 
Mode from the Options menu. 

Time Mode 

This option is for Sync files to be played back with the Soundtrack Playback Driver. I 
displays the Cue Time edit field in seconds. 

Frame Mode 

This option is for Sync files to be played back with the Autodesk Animator Playback 
utility, which plays back Autodesk™ Animator .FL! files. It displays the Cue Time ed 
field in frame units. 

The Help Menu 
Help ... 
When you choose the Help ... command from the Help menu, a window opens on the 
screen containing summarized information on how to operate the Soundtrack 
Synchronization Editor and how to use its various features. To navigate through the 
different topics, use the following buttons, which are displayed at the top of the 
window: 

Index 
Goes back to the Index page, which lists the various topics contained in Help. 

Back 
Goes back to the previous topic that was selected. 

<< Browse 
Displays the previous topic in the index. 

Browse>> 
Displays the next topic in the index. 

Close 

Closes the Help window. 
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get information on a given subject: 

With the Help window open, press the <Index> button. 

Select the topic you want in the list. 

Press OK. A page will open giving information on the selected topic. Use the 
vertical scroll bar or the vertical arrow keys ( [1.J and JJ ) to access all the 
information on that topic. 

Use the buttons at the top of the window to navigate from one topic to another. 

out. .. 
en you choose the About ... command from the Help menu, a window will open on 
screen giving the date and version number of the Soundtrack Synchronization 
tor. 
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Soundtrack Playback Driver 
1 Soundtrack Playback driver is a memory resident program that synchronizes 
ture files with Sync files created using the Soundtrack Synchronization Editor. 

l Soundtrack Playback driver uses five memory resident drivers that are necessary 
the playback of music and sampled sounds. The executable files for these drivers 
· CTRLDRV.EXE, WAVEDRV.EXE, FMDRV.EXE, RL2DRV.EXE and TIMERDRV.EXE. 

, For more information on drivers, see "Appendix D: Drivers I TSRs''. 

~se drivers must be loaded into memory to allow playback of Sync files created with 
: Soundtrack Synchronization Editor. When you use the Soundtrack Synchronization 
itor program, you do not have to load these drivers independently. The program has 
atch file that automatically loads the drivers. If you have not previously used the 
tor, you can load the drivers independently by typing the following command at the 
1S prompt, which loads all the necessary drivers: 

drivers 

~ can then load the Soundtrack Playback driver by typing: 

strkdrv fileName 

tere f ileName is the name of the Sync file you want to use for your presenta­
n. Once the drivers are loaded, you can begin your graphics presentation. After­
.rds, you may remove the Soundtrack Playback driver from memory by typing the 
lowing: 

strkdrv /r 

ice loaded, the Soundtrack Playback driver resides in memory where it traps the DOS 
mmands issued by applications to load a file. When the filename of a loaded file 
rresponds to the one of the pictures defined in the Sync file, it starts running the 
wence of cues defined for that picture. 

r example, on a presentation graphics package, one picture could be defined in the 
undtrack Synchronization Editor for each of the images that would be played in a 
esentation. The Soundtrack Playback driver could then trigger different audio events 
each picture to enhance the dramatic effect of the presentation. 

1e Soundtrack Playback driver does not limit itself to synchronizing with picture files 
.d is not dedicated to any graphics package. It could, for instance, synchronize audio 
ents to files that would be typed in from a batch file, or to text files opened by a word 
ocessor. 
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Autodesk Animator 
Playback Utility 

e Autodesk Animator Playback utility is a program that synchronizes Autodesk TM 

imator .FLI files with Sync files created using the Soundtrack Synchronization 
itor. 

e Autodesk Animator Playback utility uses five memory resident drivers that are 
cessary for the playback of music and sampled sounds. The executable files for these 
ivers are CTRLDRV.EXE, WAVEDRV.EXE, FMDRV.EXE, RL2DRV.EXE and 
\1ERDRV.EXE. 

, For more information on drivers, see "Appendix D: Drivers I TSRs". 

ese drivers must be loaded into memory to allow playback of Sync files created with 
e Soundtrack Synchronization Editor. When you use the Soundtrack Synchronization 
litor program, you do not have to load these drivers independently. The program has 
>atch file that automatically loads the drivers. If you have not previously used the 
itor, you can load the drivers independently by typing the following command at the 
)S prompt, which loads all the necessary drivers: 

drivers 

ice the drivers are loaded, you can begin your animation playback by typing the 
!lowing: 

playanim fileName 

here fileName is the name of the Sync file you want to use for your 
esentation. 

1e program will then display the first frame of the animation. 

·ess ~ to start playback of the "Sync File". 
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Batch File Utiliti1 
ROL2 Playback Utility 
The ROL2 Playback utility is a small program that allows the user to play RL2 musi< 
files from the DOS command line or from a batch file. 

The format of the command running the ROL2 Playback utility is the following: 

playrl2 fileName [/q] 

Where fileName is the name of the ROL2 music file (.RL2) to be played. 

The optional "/ q" parameter can be used to start the playback of the RL2 song file 
immediately returns control to DOS. The playback of the song will be taken in chaq 
by the memory-resident ROL2 Playback driver. 

If you enter "playrl2" alone or with the option"/?" ("playrl2 /?"), the 
program displays help lines giving summarized information on program parameters 

The ROL2 Playback utility uses the following five drivers, which have to be loaded 
before running it: 

• Control driver (CTRLDRV.EXE) 

• FM driver (FMDRV.EXE) 

• Wave driver WA VEDRV.EXE) 

• Timer driver (TIMERDRV.EXE) 

• ROL2 Playback driver (RL2DRV.EXE) 

Drivers can be loaded by typing the following batch file command at the DOS prom1 

drivers 

Digitized Sound Playback Utility 
The Digitized Sound Playback utility is a small program that allows to play back 
digitized sound files (recorded in the .SMP format) from the DOS command line or 
from a batch file. 

The format of the command running the Digitized Sound Playback utility is the 
following: 

playdigi fileName [/pl [/n] 

Where fileName is the name of the digitized sound file (.SMP) to be played. 
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Digitized Sound Playback Utility 

ire "p" in the option" /p", may be "c" ( center), "r" (right), or "1" (left), indicating 
stereo position you want for the playback of the digitized sound file. 

ire "n" in the option" /n", may be a number from Oto 100, indicating the volume 
want for the playback of the digitized sound file. 

m enter "playdigi" alone or with the option"/?" ("playdigi /?"),the 
µ-am displays help lines giving summarized information on program parameters. 

Digitized Sound Playback utility uses the following two drivers, which have to be 
led before running it: 

Control driver (CTRLDRV.EXE) 

Wave driver (WAVEDRV.EXE) 
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Appendix, 
Trouhleshooti, 

In this section, you will find solutions to problems you may encounter when installi 
and using the Ad Lib Gold Card. The following list of usual problems is addressed ir 
detail afterwards. 

Usual Problems 
1. The Setup program seems to indicate that the Gold card is properly installed I 

does not produce any sound. 

2. When trying to save a sample created with the Voice Pad program, the compUI 
locks up. 

3. The serial mouse does not work properly with the Ad Lib card installed. 

4. The FM synthesis, MIDI or sampling does not work. 

5. When running software for the Gold card, the computer hangs. 

6. The FM synthesis and the digital sampling work fine but the MIDI does not wr 

7. The CD-ROM does not work. 

8. The joystick does not work. 

9. Hard disk or floppy disk does not work when the Gold card is present in the 
computer. 

10. When recording with a microphone, the level is too low. 

11. The sound quality is poor when recording from a CD player or other electronic 
audio device. 

12. The computer does not boot. 
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1roblem: 
"he Setup program seerns to indicate that the Gold card is properly installed but 
!oes not produce any sound. 

Nhat could be wrong: 

• The headphones, external speaker(s) or stereo system are incorrectly 
connected. 

• The volume in the Mixer Panel is set too low. 
• There is no musical program running. 

Nhat to do: 

• Execute the Test program. 
• Make sure that all connectors are securely inserted. 
• Disconnect any external loudspeaker or stereo system and try the card with 

headphones. 
• Open the Mixer Panel and make sure that the volume is set high enough. 
• Check the Sub Mixer parameters: the FM and Sampling parameter settings 

should be at 100. 
• Reset the computer. 

1roblem: 
¥hen trying to save a sample created with the Voice Pad program, the computer 
oclcsup. 

Nhat could be wrong: 

• The controller card for the hard disk is using the same DMA channel as the Gold 
card. 

Nhat to do: 

• Run the Setup program and change the setting of the DMA channel. (Be aware 
that some DMA channels can already be used by other devices.) 

1roblem: 
7'he serial rnouse does not work properly with the Ad Lib card installed. 

Mi.at could be wrong: 

• The serial mouse is using the same interrupt line as the Gold card. 

Mtatto do: 

• To change the interrupt, run the Setup program and, being in the Main 
Selection menu, select "Configure the Card and Drivers". Note that COM 2, 
which is used quite often by a mouse or a modem, is frequently assigned to 
IRQ3, and COMl to IRQ4. 
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4. Problem: 
The FM synthesi,s, MIDI or sampling does not work. 

What could be wrong: 

• This problem could be caused by a parallel printer port which is using hard, 
interrupt 7. The Ad Lib Gold card can share this interrupt with the parallel 
printer in most cases. However, on some PC's the parallel port may prevent 
Gold card from receiving this interrupt. 

What to do: 

• Run the Setup program and, being in the Main Selection menu, select 
"Configure the Card and Drivers", then change interrupts. 

5. Problem: 
When running software for the Gold card, the computer hangs. 

What could be wrong: 

• This could be caused by an interrupt or port address conflict with another 
board. 

What to do: 

• Remove the drivers for all the boards and reinstall them one by one, trying t 
application every time until the conflict occurs. 

6. Problem 
The FM synthesi,s and the digital sampling work fine but the MIDI does not wr 

What could be wrong: 

• The software does not support the MIDI interface. 
• The Dual joystick selector jumpers are not set properly. 
• The MIDI cables are not properly connected. 
• The MID I interface is not set to the proper port address or interrupt. 
• The appropriate drivers are not loaded. 

What to do: 

• Make sure that the MIDI software does support the Gold card. Ifnot certain 
should contact the manufacturer. 

• Set the Dual joystick selector jumpers in the "single joystick with MIDI optic 
position. Refer to the section "Getting Installed: Installing the Hardware" fo 
the complete procedure. 

• The MIDI cables should not be inverted, the MIDI Out of the interface must 
into the MIDI In of the device and vice versa. 

• If the port address or interrupts must be changed run the Setup program an 
being in the Main Selection menu, select "Configure the Card and Drivers". 

• Make sure that the appropriate drivers are loaded for the MID I application. 
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1roblem: 
'he CD-ROM drive does not work. 

Vhat could be wrong: 

• The cables are not properly connected. 
• The appropriate drivers are not loaded. 
• There is a OMA conflict. 

Vhat to do: 

• Make sure that: 
-The cables are properly connected between the Ad Lib Gold card and the 

CD-ROM Drive. 
-The CD-ROM drivers are loaded from the CONFIG.SYS and AUTO EXEC.BAT 

files. 
-The haiware specifications in the command lives for CONFIG.SYS and 

AUTOEXEC but ( for OMA channels and interrupt lines) correspond to the 
actual Gold card configuration. 
For more details on the configuration of the CD-ROM drivers, see the booklet 
included with your CD-ROM daugther board. 

>roblem: 
"he joystick does not work. 

Nhat could be wrong: 

• The jumpers on the Gold card are improperly set. 
• This will also happen when trying to use a joystick with another game board, or 

trying to use the game port on the Ad Lib card with another game card installed. 

Nhat to do: 

• Make sure the jumpers are not missing on the game port switch. 
• If you want to use your former game port you must disable the game port on the 

Ad Lib card. Refer to the section "Installing the Hardware: Hardware 
Configuration Settings". 

• Should you want to use the game port on the Gold card, then you should remove 
the conflicting game board or disable it if possible. 
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9. Problem: 
Hard disk or floppy disk does not work when the Gold card is present in the 
computer. 

What could be wrong: 

• The hard disk or floppy disk is using the same DMA channel as the Gold card. 

What to do: 

• To change a DMA channel used by the Gold card run the Setup program and, 
being in the main Selection menu, select "Configure the Card and Drivers". If 
DMA channels are available for the Gold card, you can choose a configuration 
that lets you use drive the Sampling and SCSI by interrupt. 

10. Problem: 
When recording with a microphone, the level is too low. 

What could be wrong: 

• The microphone is not properly connected or it is connected to the wrong 
connector on the card. 

• The microphone input impedance of the Gold card is l Kn. The microphone 
should have a maximum impedance of l Kn if you do not want to lose too mw 
input level due to an impedance mismatch. 

~ The impedance is the equivalent of the electrical resistance in 
a circuit. The impedance of the source should be smaller than 
the impedance of the input it is feeding, in order not to reduce 
the voltage involved, thus the output level. 

• The microphone Input level is too low. 

What to do: 

• Make sure that the microphone is correctly plugged into the microphone inpu 
on the card (No. 7 on Figures 1), and not the auxiliary input (No. 8) nor the 
audio output (No. 9). 

• If possible, try another microphone. 
• Go into the Mixer Panel and increase the Input level parameter. 
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. Problem: 
The sound quality is poor when recording from a CD player or other electronic 
audio device. 

What could be wrong: 

• The output of the audio device is plugged into the microphone input rather than 
the auxiliary input. 

• The Input level in the Mixer Panel is set too high. 

What to do: 

• Make sure that the device is correctly plugged into the auxiliary input on the 
card (No, 8 on Figure I ), and not the microphone input (No. 7) nor the audio 
output (No. 9). 

• Go into the Mixer Panel and decrease the Input level parameter . 

. Problem: 
The computer does not bout. 

What could be wrong: 

• The programmed configuration of the Control chip has been lost because of a 
configuration error or a program failure. 

What to do: 

• Reset the Control chip configuration by proceeding as follows: 
I. Shut down the computer. 
2. Remove the computer cover. 
3. Locate the Control chip reset jumper (refer to Figure I, No. 13). 
4. Unplug the Control chip reset jumper from the two left pins and replug it 

onto the two right pins, 
5. Replace the computer cover ( optional). 
6. Turn on the computer and load the Control driver by typing ctrldrv. The 

program will not be loaded and will indicate "Card not found". 
7. Then reset the Control chip configuration by typing setup /R. 

8. Shut down the computer. 
9. Remove the computer cover (if replaced), unplug the Control chip reset 

jumper from the two right pins and replug it on the two left pins. 
10. Replace the computer cover. 
11. Turn on the computer and load the Control driver by typing ctrldrv. The 

program will now been normally loaded in memory. 
12. This procedure restores the Control chip default configuration, which is: no 

DMA, card address 388H, and IRQ 7"-0". If you wish change this default 
configuration, run the Setup program by typing setup. 
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Each Ad Lib Gold card is systematically checked prior to shipping in order 
ensure that it is free from technical problems. However, if you encounter a 
problem that you are not able to solve after following the directions in this 
guide, do not hesitate to call our technical support department. Our techni 
support number is: 418-529-6252. You will need the following information o 
hand when you call: 
• the serial number located on the back of your Ad Lib Gold card; 
• this manual. 
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Appendix B: 
List of Installed Files 

Ad Lib Gold Software included with the program disks contains, when 
om pressed and installed, several files related to the utilization of the Gold card: 
'ers, application programs, music, sounds, and other various files. These files are: 

README.TXT 
This file is not compressed on the program disk. It contains information on the 
latest program updates, if there are any, and any other pertinent information. 

CTRLDRV.EXE 
This file is not compressed on the program disk. It contains the Ad Lib Gold 
Control chip driver. This low level driver is used by other programs, such as the 
Setup program, to implement: DMA channel & interrupt number select; sampling 
source select; sampling gain and input filter; microphone input gain; sampling 
output filtering and volume & tone control; mixing control; card localization setup 
and ID code reading; saving registers in non-volatile memory. 

SETUPGLD.EXE 
This file is not compressed on the program disk. It contains the Setup program. 
This program enables you to install the drivers and all associated programs, to 
configure your Ad Lib Gold card and to change the hot keys used by Mixer Panel 
and ROL2 Playback TSRs. 

SETUP.BAT 
This file is not compressed on the diskette. It contains the DOS command 
sequence which loads the necessary drivers and calls the Setup Program. 

·ivers and TSRs 
FMDRV.EXE 
This file contains the FM driver. This low level driver implements: preset change; 
note on; note off; pitch bend; volume and stereo positioning. 

WAVEDRV.EXE 
This file contains the Wave driver. This low level driver implements: recording 
and playback of samples by DMA and interrupt. 

TIMERDRV.EXE 
This file contains the Timer driver. This low level driver implements: the five 
timers of the Yamaha Magic Chip Set. 
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• MIDIDRV.EXE 
This file contains the MIDI driver. This low level driver implements: MIDI In a 
Out serial port control. 

• RL2DRV.EXE 
This file contains the ROL2 Playback driver. This low level TSR driver 
implements: playback of the .RL2 music files and user control commands. 

• MIXER.EXE 
This file contains the Mixer Panel TSR. This memory resident application al101 

for the control of the programmable volume and tone control, mixer settings, , 
surround features. 

• ALARMDRV.EXE 
This file contains the Alarm driver. This low level driver implements: playback 
Voice Pad alarms. 

• SYNCDRV.EXE 
This file contains the Soundtrack Playback driver. This low level driver 
implements: playback of Soundtrack Synchronization Editor Sync files (.SNC) 

• SOUND.COM 
This file is the sound driver for the original Ad Lib Music Synthesizer Card. Th 
program might be necessary in some cases for running programs compatible \I 
the original Ad Lib card. 

Application Programs (Executables) 
• TESTGOLD.EXE 

This file contains the Ad Lib Gold Test Program. This program enables you to 
verify that the Gold card is functioning properly in all of its different compone1 

• JUKEG.EXE 
This file contains the executable code of Juke Box Gold. 

• VPAD.EXE 
This file contains the executable code of Voice Pad. 

• SNDTRACK.EXE 
This file contains the executable code of Soundtrack Synchronization Editor. 

• ANIMGLD.EXE 
This file contains the executable code of Autodesk Animator Playback utility. 

• PLAYRL2.EXE 
This file contains the executable code ofROL2 Playback utility. 

• PLAYDIGI.EXE 
This file contains the executable code of Digitized Sound Playback utility. 
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itch Files 
TEST.BAT 
This file contains the DOS command sequence which loads the necessary drivers 
and calls the Test Program. 

JUKEGOLD.BAT 
This file contains the DOS command sequence which loads the necessary drivers 
and calls the Juke Box Gold Music Playback Program. 

VOICEPAD.BAT 
This file contains the DOS command sequence which loads the necessary drivers 
and calls the Voice Pad Record and Playback Program. 

STRACKED.BAT 
This file contains the DOS command sequence which loads the necessary drivers 
and calls the Soundtrack Synchronization Editor. 

STRKDRV.BAT 
This file contains the DOS command sequence which loads the necessary drivers 
and calls the Soundtrack Playback driver. 

PLAYANIM.BAT 
This file contains the DOS command sequence which loads the necessary drivers 
and calls the Autodesk Animator Playback utility. 

DRIVERS.BAT 
This file contains the DOS command sequence which loads all drivers necessary 
to run Ad Lib Gold programs. 

ther Files 
*.RL2 
The ".RL2" files contain the pieces of music that will be played with the Juke Box 
Gold. 

*.SMP 
The ".SMP" files contain the PCM digitized sounds. TESTGLDl.SMP is the sound 
file that will be used by the Test program. 

FMSOUND.BNK 
This file contains the FM synthesized instrument sounds compatible with the 
OPL3 FM synthesis chip. 
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Files Created by Programs 
• *.PAD 

A ".PAD" file is created for each voice note you save in the Voice Pad program t 
store the digitized recording. 

• DIRVOICE.PAD 
This is a bank file created the first time you save a voice note in the Voice Pad 
program to store information about the voice notes. 

• JUKEBOX.DAT 
This file is created the first time you make a selection of songs in the Juke Box 
Gold program, permitting not to lose your selection even after rebooting the 
computer. 

• *.SNC 
A ".SNC" file is created for each Sync file you save in the Soundtrack 
Synchronization Editor program. SYNCDEMO.SNC is an example of a Sync file 
created with this program. 
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etup Program 
.ri error has occurred while modifying the file." 

The Setup program was unable to complete the modification of the AUTO EXEC.BAT 
or CONFIG.SYS files. 

n See ''Software In~tallation and Configuration". 

~st Program 
irror loading sample. " 

Test program was able to open the sample but found that the contents have been 
corrupted. Using the Setup program, reinstall the TESTGLDl.SMP file from your 
original diskette. 

irror playing sample. " 

Test program is unable to play the sample. The memory may be full. Check the 
configuration of the card. 

lrror recording sample . " 

Test program is unable to record the sample. The memory may be full. Check the 
configuration of the card. 

?roblem with TIMER 1 on the FM chip" 
?roblem with TIMER 2 on the FM chip" 
?roblem with TIMER 1 and 2 in concurrent mode on the 
~ chip" 
?roblem with TIMER 0 on the MMA chip" 
?roblem with TIMER 1 on the MMA chip" 
?roblem with TIMER 2 on the MMA chip" 
?roblem with TIMER 0, 1 and 2 in concurrent mode on 
1e MMA chip" 

All these messages state that the Test program detected a Timer problem. First 
check the configuration of the card. If the problem persists, reboot the computer, 
reload the Test program and try again. 

uke Box Gold Program 
As the error messages are the same as for the ROL2 Playback driver, see this 
section below. 
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Voice Pad Program 
"There is no DIRVOICE.PAD file. This file is created 
after the first recording. No alarm will be played." 

This message appears at the loading when the program does not find the 
DIRVOICE.PAD file, which is a collection of voice notes. If you want voice note 
alarms be played, the DIRVOICE.PAD bank file must be in the same directory as 
the Voice Pad program. If there is no DIRVOICE.PAD file present, the first time y 
save a voice note, the program will automatically create the DIRVOICE.PAD file t 
store your voice note. 

"File handling error" 

The Voice Pad program cannot handle the file because its format is not compatib 
with the version you are using. 

"OUt of memory" 

Voice Pad cannot function because the memory space (RAM) is insufficient. The 
space required by the program is greater than the space available. 

"Wave driver error" 

The Voice Pad program cannot function because the Wave driver does not respon 

"Error when opening" 

The program cannot load the file , because a reading error occurred. 

"Disk error" 

An error occurred while writing or reading the file on the disk. Simply trying agaii 
will be sufficient in many cases to make the same operation work normally. If the 
problem persists and the same message keeps appearing, refer to your DOS manu 
for more details on possible solutions. 

"A problem occurred with the alarm manager. No alarm 
will be played." 

The Voice Pad alarm manager cannot function because Alarm driver 
(ALARMDRV.EXE) is not loaded in memory or does not respond. 

"Unable to save. The disk you are saving to is probabl 
full." 

There is not enough space on the disk to save the file. Clean up your disk by 
deleting all unnecessary files and try again. 

"Error in date alarm. The voice note is not saved. Use 
this format: yy/mm/dd." 

The program cannot store the voice note because the date alarm specified does rn 
correspond to the required format. Correct the date alarm format as requested 
before saving the file. 
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rror in time alarm. The voice note is not saved. Use 
.is format: hh:mm." 

The program cannot store the voice note because the time alarm specified does not 
correspond to the required format. Correct the time alarm format as requested 
before saving the file. 

rror in snooze alarm. The voice note is not saved. 
e this format: mm." 

The program cannot store the voice note because the snooze specified does not 
correspond to the required format. Correct the snooze format as requested before 
saving the file. 

here is nothing to save." 

The program does not save the opened file because there have been no changes or 
modifications entered since the last save, or because it is an empty file. 

ast voice note was not saved. Do you really want to 
it?" 

The program warns you that there were changes or modifications entered since the 
last save and asks if you want to save them before exiting. 

mndtrack Synchronization Editor 
icture name already exists." 

This message appears when you type in the Add Picture ... dialog box a picture 
name that is already included in the picture list. The program cannot make a Sync 
file that refers to the same picture twice in the picture list. 

emory full." 

Soundtrack Synchronization Editor cannot function because the memory space 
(RAM) is insufficient. The space required by the program is greater than the space 
available. 

JL2 Playback Driver 
rogram already installed." 

The ROL2 Playback driver will not be installed because it has been previously 
installed in memory, probably within a program batch file. 

o more user interrupts available." 

The ROL2 Playback driver will not function because there are no software 
interrupts available, they are being used by other programs. 

annot remove as driver not previously installed." 

The ROL2 Playback driver will not be removed because it was not installed in 
memory. 
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"Unable to remove as other software has been loaded 
after this one." 

The ROL2 Playback driver will not be removed because there are one or more 
driverstrSRs that have been installed after it. In the list of drivers/rSRs installe, 
only the last one can be removed. 

"Missing driver(s} or SAMPLES.BNK" 

The ROL2 Playback driver cannot be loaded because an underlying driver neces: 
to its functioning cannot be found in memory. 

OR 

The ROL2 Playback driver cannot be loaded because the SAMPLES.BNK file can 
be found in the same directory or the directories specified by the GOLDPATH 
environment variable. 

Other Drivers 
"xxx already installed." 

The driver xxx will not be installed because it has been previously installed in 
memory, probably within a program batch file. This is a normal operation messa 
and you should not worry about it. 

"Gold Card not found." 

Driver cannot identify the Gold card. Reset the configuration by typing: setup 1 

"Control Driver not found (CTRLDRV.EXE}." 

The driver, called separately or by a program batch file, cannot be loaded becau: 
the file cannot be found in memory. Type ctr l drv and try again. 

"Unable to link with Control Driver (CTRLDRV.EXE}." 

A program cannot function because the driver does not respond. Reboot the 
computer and try again. 

"Timer Driver not found (TIMERDRV.EXE}." 

The driver, called separately or by a program batch file, cannot be loaded becau: 
the file cannot be found in memory. Type time rdrv and try again. 

"Unable to link with Timer Driver (TIMERDRV.EXE}." 

A program cannot function because the driver does not respond. Reboot the 
computer and try again. 

"MIDI Driver not found (MIDIDRV.EXE}." 

The driver, called separately or by a program batch file, cannot be loaded becau: 
the file cannot be found in memory. Type mididrv and try again. 

"Unable to link with MIDI Driver (MIDIDRV.EXE}." 

A program cannot function because the driver does not respond. Reboot the 
computer and try again. 
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M Driver not found (FMDRV.EXE)." 

The driver, called separately or by a program batch file, cannot be loaded because 
the file cannot be found in memory. Type f mdrv and try again. 

nable to link with FM Driver (FMDRV.EXE)." 

A program cannot function because the driver does not respond. Reboot the 
computer and try again. 

ave Driver not found (WAVEDRV.EXE) ." 

The driver, called separately or by a program batch file, cannot be loaded because 
the file cannot be found in memory. Type waved rv and try again. 

nable to link with Wave Driver (WAVEDRV.EXE)." 

A program cannot function because the driver does not respond. Reboot the 
computer and try again. 

layback Driver not found (RL2DRV.EXE)." 

The driver, called separately or by a program batch file, cannot be loaded because 
the file cannot be found in memory. Type r 12 drv and try again. 
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Ad Lib Gold applications, like Juke Box, Voice Pad, as well as third party applications 
use memory resident programs as resources. These programs are referred to as drive1 
or TS Rs (Terminate and Stay Resident). 

We usually refer to memory resident programs as drivers when they work in the 
background as low-end resources for other programs (i.e. without a user interface). 
Although any memory resident program may also be called a TSR program, we usuall: 
keep this generic name for programs designed to be controlled by the end user, 
whether using specific key stroke combinations, as with the ROL2 Playback utility 
(PLAYRL2.EXE), or through a pop-up window, as in the Ad Lib Gold Mixer Panel 
(MIXER.EXE). 

TSRs and drivers are loaded in memory much like a standard executable program: 
whether their name is typed in or appears in a batch file. Once loaded the TSRs and 
drivers remain in memory, ready to offer services to the end user or to the applicatim 
that requires them. Being independent from the applications, TSR and drivers are a 
simple method of providing hardware independence to applications and to ease 
software upgrades. 

When loaded, a TSR or a driver usually prints its name and version number to the 
screen. If a driver has already been loaded once, it will indicate that it is already 
present in memory, and will not load a second time. 

A message indicating that the TSR or the driver is already loaded is a normal messag 
and should be no cause for alarm. 

While most TSRs are simply low-end resources working in the background without a, 
user interface, they can also be designed to be controlled with specific key stroke 
combination, like the ROL2 Playback utility (PLAYRL2.EXE), or through a pop-up 
window like the Ad Lib Gold Mixer Panel (MIXER.EXE). 

The drivers supplied with the Ad Lib Gold card are the following: 

CTRLDRV.EXE 

Control Driver: Offers services related to the basic configuration of the Gold Care 
and to the Gold card mixer. 

It also acts as the manager of all other Ad Lib Gold drivers in memory. For this 
reason, the Control Driver should always be the first driver to be loaded in memo 
as is the case in the provided batch files. 
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!'MDRV.EXE 

FM Driver: Provides applications with services related to the generation of FM 
sounds on the Gold card. 

'1AVEDRV. EXE 

Wave Driver: Provides applications with services that allow the recording and 
playback of digitized sounds. 

rIMERDRV. EXE 

Timer Driver: Gives access to the high-resolution hardware timers available on the 
Gold card. These timers may be used, for example, by games and music sequencing 
programs. 

UDIDRV.EXE 

MIDI Driver: Can be used used by applications to read and write data to and from 
the MIDI port. 

I.LARMDRV.EXE 

Alarm Driver: Used to play back alarms of voice notes created by the Voice Pad 
program. 

lL2DRV.EXE 

ROL2 Playback Driver: Is used by applications to control the playback of Ad Lib 
music files (.RL2 files). It is a powerful utility that uses the services of the other 
underlying drivers to simplify the task of integrating music and digitized sound to 
applications. It is used, for example, by the Ad Lib Juke Box Gold program. (See 
below for the options supported with this driver.) 

IYNCDRV. EXE 

The Soundtrack Playback driver is used to synchronize files loaded by a third-party 
application with audio events, according to the information contained the 
Soundtrack Synchronization Editor Sync files (.SNC). 

,pplications can use one or more of these drivers. To make sure that the drivers are 
roperly loaded when calling an application, each application is provided with a batch 
.le that loads the appropriate drivers. 

'he following batch file command loads all drivers necessary to run Ad Lib Gold 
rograms: 

drivers 
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ROL2 Playback Driver Options 
You normally do not have to load the ROL2 Playback driver independently to run Juke 
Box Gold. The application has a batch file that automatically loads the RL2DRV.EXE 
file. But if it is necessary for some reason, the driver can be loaded and removed by 
typing the following commands and options at the DOS prompt: 

rl2drv 

Loads the ROL2 Playback driver into the computer's memory (RAM). 

rl2drv /r 

This option removes the ROL2 Playback driver from the computer's memory when i 
is installed but you do not wish to use it. Once this command is entered, the 
program will display a message indicating that the ROL2 Playback driver has been 
removed and is no longer loaded. 

rl2drv /vn 

This option disables the specified sampling voice "n", which can be "1" or "2". Use 
two options consecutively, " / v 1 / v2 ", to disable the two sampling voices. 

The playback of sampled voices consumes a lot of computer resources. On slower 
PCs, or when the ROL2 Playback driver is used in conjunction with more 
demanding applications, this option can be used to insure a proper functioning of 
all parts involved. 

rl2drv /Spath 

This option specifies to the driver where it can find the data files used for song files 
You can specify a path if the data files are not in the current directory and are not 
in the directories specified by the GOLDPATH environment variable. 
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fhis section is a general reference guide that details the capabilities of the Ad Lib Gold 
~ard and the parameter values of its different components. 

FM Synthesis 
fM Synthesizer Chip .............................. YMF262 
Number of FM Voices 

When Used in Mono .................................... 20 
Number of FM Voices 

When Used in Stereo ............... ........ ............ 20 
Two Operator FM Synthesis ............................... ✓ 
Four Operator FM Synthesis .............................. ✓ 
Number of FM Waveforms ................................. 8 
Wait Time Between Chip Writes ............. 0.28 µs 
FM DAC ....................................................... 16 bits 
FM Dynamic Range ..................................... 96 dB 

Sampling 
Sampling Chip ......................................... YMZ263 
SamplingDAC 

(Sampling Resolution) ........................ 12 bits 
Sampling Dynamic Range .......................... 72 dB 
PCM Data Accepted ................. 16, 12 and 8 bits 
Sampling Record 

and Playback Channels ................................ 2 
Sampling Rates (Stereo & Mono) ....... 44.1 KHz 

...... 22.05 KHz 

.... 11.025 KHz 

........ 7.35 KHz 

.... 5.5125 KHz 
Digitized Sound 

Data Format.. ........................ PCM & AD PCM 
Hardware Compression/ 

Decompression ....................................... 3 to 1 
Simultaneous Use of two 

OMA Channels ............................................... ✓ 
Sampling FIFO Buffer ................... 2 x 128 Bytes 
Programmable Interrupts ................................. ✓ 
Available Interrupts lines .................... 4 choices 
Variable Antialiasing Filter ................. .............. ✓ 
Double Oversampling Digital Filters ............... ✓ 
Double Undersampling Digital Filters ............ ✓ 

Mixer 
On-Board Analog 

Stereo Mixer ...................................... 8 entries 
Accepts CD-Audio 

(RedBook) Input... ........................................ ✓ 
Volume Control on Each Source ............... 42 dB 

......... 128 steps 
Stereo Output 

Power Amplifier ............ 1.2 Watt RMS in 8Q 
Output Volume Range ................................ 80 dB 

........................ 2 dB steps 
Bass and Treble Range .... ........ ................ ±12 dB 
Programmable Gain 

for Audio Input .. ..... .. ..................................... ✓ 
Input Impedance ......................................... l Kn 
Input Sensitivity ................................... I-100 mV 

Interfaces 
MIDI Interface Ports ........... .. ..... In, Out & Thru 
Simultaneous MIDI In & Out ............................ ✓ 
MIDI FIFO Buffer ..................................... 16 byte 
Joystick Port .............. ..... ..................................... ✓ 
Individual Timers ................................................ 5 

Programmable 
Parameters 
Programmable Output Volume Control .......... ✓ 
Programmable Output Treble Control ............ ✓ 
Programmable Output Bass Control ............... ✓ 
Programmable Gain for Mike & Aux. Input .... ✓ 
Programmable Card Localisation .. ............... 128 
Programmable OMA Channel Selection ......... ✓ 
Programmable Interrupt Selection ................. ✓ 
Programmable On-Board Chip Select ............. ✓ 
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Registers 
ID Code Available ............................................... ✓ 
Directly Accessible 

Control Registers .......................................... ✓ 
Readable Control Registers .............................. ✓ 
Registers Stored in 

Non-volatile Memory ..................................... ✓ 
Non-volatile Memory (EEPROM) ........... 256 bit 

Option Connectors 
Connectors for Surround Sound Option .......... ✓ 
Connector for PC Speaker.. ............................... ✓ 
Connector for Internal Stereo Aux. Input ...... ✓ 
Connector for CD-ROM Option ........................ ✓ 
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Alarm driver 52 
daily alarm 48 
date alarm 48 
snooze 49 

ALARMDRV.EXE 86, 95 
ANIMGLD.EXE 86 
Audio output 11, 21 
Autodesk Animator Playback utility 71 
AUTO EXEC.BAT 25, 52 
Auxiliary input 11, 21, 22 
Auxiliary volume 34 

B 
Balance 32 
Bass 32, 40 
Batch File Utilities 73 
Bracket connectors 11 

C 
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CTRLDRV.EXE 85, 95 
Cue ti5, 65 

D 
Digitized Sound Playback utility 73 
DIRVOICE.PAD 88 
DMA channels 16, 79 
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DRIVERS.BAT 89 
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F 
FMvolume34 
FMDRV.EXE 85, 95 
FMSOUND.BNK 87 
Frame mode 62 

G 
Game Port/MIDI connector 11 

lndeJ 

GOLD environment variable 34 
GOLD PATH environment variable 34 

H 
Hot Keys 

enable/disable Surround :l6 
pause and resume 41 
play songs 41 
scan songs 41 
set master volume 36 
stop playback 41 

Input level 32 
Interrupt lines 16, 79 

J 
,Juke Box Gold :l7 
.JUKEBOX.DAT 88 
,JlJKEG.EXE 86 
.JUKEGOLD.BAT 87 
Jumpers 14 

Control chip resetjumper 15 
dual joystick selector jumpers 14, 19 
game port enable jumper 14, 19 
port address jumper 15, 19 

M 
Messages 

See Error messages 
Microphone gain 46 
Microphone input 11, 21 
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MIDI/Game port 22 
MID ID RV.EXE 86, 95 
Mixer Panel TSR 29 
MIXER.EXE 30, 86 

0 
Output mode 32, 40 

p 
PAD files 88 
PLA YANIM.BAT 87 
PLAYDIGI.EXE 86 
PLAYRL2.EXE 86 

0 
Quick Start 5 

R 
README.TXT 7, 85 
RL2 files 86 
RL2DRV.EXE 86, 95 
ROL2 Playback driver 

command line options 96 
ROL2 Playback TSR 41 
ROL2 Playback utility 73 

s 
Sampling volume 34 
Setup program 23, 79, 80 
SETUP.BAT 85 
SETUPGLD.EXE 85 
SMP files87 
SNC files 88 
SNDTRACK.EXE 86 
SOUND.COM 86 
Soundtrack Playback driver 65 
Soundtrack Synchronization Editor 53 
STRACKED.BAT 87 
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Sync files 55, 71 
SYNCDEMO.SNC 88 
SYN CD RV.EXE 86, 95 

T 
Technical specifications 97 
Test program 26 
TEST.BAT87 
TESTGLDI.SMP 87 
TESTGOLD.EXE 86 
Time mode 62 
TIMERDRV.EXE 85, 96 
Treble 32, 40 
Troubleshooting 78 

V 
Voice note 45, 46, 4 7 

daily 50 
date 50 
display options 50 
standard 49 

Voice Pad program 44 
VOICEPAD.BAT 87 
Volume 32, 40 
VPAD.EXE86 

w 
WAVEDRV.EXE 85, 95 
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